Introduction........................................................................................................................................2
Part I: Virginia Law Review Conventions................................................................................................3
  Bluebook Rule 1.1: Citation Sentences and Clauses in Law Reviews (BB p. 57).................................3
  Bluebook Rule 1.2: Introductory Signals (BB p. 58)...............................................................4
  Bluebook Rule 1.3: Order of Signals (BB p. 60)........................................................................5
  Bluebook Rule 1.4: Order of Authorities (BB p. 61)....................................................................5
  Bluebook Rule 1.5: Parenthetical Information (BB p. 64)...........................................................5
  Bluebook Rule 2: Typefaces for Law Reviews (a.k.a. VLR Italicization Conventions) (BB p. 67)....6
  Bluebook Rule 2.1: [Italicization in] Citations (BB p. 67)............................................................7
  Bluebook Rule 2.2: [Italicization in] Textual Material (BB p. 69)..............................................8
  Bluebook Rule 4.2(a): “Supra” (BB p. 80)...................................................................................9
  Bluebook Rule 4.2(b): “Hereinafter.” (BB p. 80)..........................................................................9
  Bluebook Rule 5.1: Formatting of Quotations (BB p. 82)..............................................................10
  Bluebook Rule 5.2: Alterations and Quotations Within Quotations (BB p. 83).............................10
  Bluebook Rule 5.3: Omissions and Ellipses in Quotations (BB p. 85)..........................................11
  Bluebook Rule 6.1: Abbreviations (BB p. 87).............................................................................13
  Bluebook Rule 6.2: Numerals and Symbols (BB p. 88)...............................................................13
  Bluebook Rule 8: Capitalization (BB p. 91)..................................................................................15
  Bluebook Rule 9: Names of Courts, Judges, and Professors (BB p. 94).......................................16
  Bluebook Rule 10: Cases (BB p. 94)..........................................................................................17
  Bluebook Rule 10.2.1(h): Business Firm Designations (BB p. 100)..........................................17
  Bluebook Rule 10.2.2: Additional Rules for Case Names in Citations (BB p. 101).......................17
  Bluebook Rule 10.3.2: Reporters (BB p. 103)..............................................................................18
  Bluebook Rule 10.6.1 Parenthetical Information Regarding Cases: Weight of Authority (BB p. 107)...18
  Bluebook Rule 10.7: Prior and Subsequent History (BB p. 109)...............................................18
  Bluebook Rule 10.8.3: Briefs, Court Filings, and Transcripts (BB p. 113).................................18
  Bluebook Rule 10.9: Short Forms for Cases (BB p. 115)............................................................18
  Bluebook Rule 12.3: Statutes: Current Official and Unofficial Codes (BB p. 123)......................19
  Bluebook Rule 12.6: Statutes: Other Secondary Sources (BB p. 127).......................................20
  Bluebook Rule 12.7: Statutes: Invalidation, Repeal, Amendment, and Prior History (BB p. 128)....20
  Bluebook Rule 12.9.1: Special Citation Forms: Internal Revenue Code (BB p. 129)....................20
  Bluebook Rule 12.10: Short Forms for Statutes (BB p. 133).......................................................20
  Bluebook Rule 13.3: Legislative Materials: Hearings (BB p. 137)..............................................20
  Bluebook Rule 13.5: Legislative Materials: Debates (BB p. 140).............................................20
  Bluebook Rule 14: Administrative and Executive Materials (BB p. 143)....................................20
  Bluebook Rule 14.2: Rules, Regulations, and Other Publications (BB p. 143).............................21
  Bluebook Rule 15: Books, Reports, and Nonperiodic Materials: Title (BB p. 151).....................21
  Bluebook Rule 15.5: Shorter Works in Collection (BB p. 153)......................................................22
  Bluebook Rule 15.10.1: Short Forms for Shorter Works in Collection (BB p. 157).......................22
  Bluebook Rule 16: Periodical Materials (BB p. 159).................................................................22
  Bluebook Rule 16.4: Consecutively Paginated Journals and Magazines (BB p. 162)....................23
  Bluebook Rule 16.5: Nonconsecutively Paginated Journals and Magazines (BB p. 162).........23
  Bluebook Rule 17: Unpublished and Forthcoming Sources (BB p. 172)....................................23
  Bluebook Rule 18.2.1: Internet Citations (BB p. 180)..............................................................24
  Bluebook Rule 18.2.2: Direct Citations to Internet Sources (BB p. 182).....................................25
  Bluebook Rule 21: International Materials (BB p. 200).............................................................26
  Bluebook Rule 21.5.2: European Union Courts (BB p. 209).....................................................26
Part II: Points of Style and Grammar..................................................................................................27
Part III: Formatting Tips...................................................................................................................34
Introduction

This manual (the *Slatebook*) provides you with the stylistic conventions used by the *Virginia Law Review*. Part I of the *Slatebook* modifies and adds to the *Bluebook*’s rules. It also explains confusing *Bluebook* rules. Please apply these *VLR* conventions to every piece that you edit. Every member of the *Law Review* must be familiar with these stylistic conventions, as well as the entire *Bluebook*. Part II of the *Slatebook* provides guidance on grammar and style and Part III lists formatting tips for editors.

Generally, grammar and punctuation should follow the sixteenth edition of the *Chicago Manual of Style*, available to all UVA law students for free if connected to the law school’s network at [http://www.chicagomanualofstyle.org/home.html](http://www.chicagomanualofstyle.org/home.html). To access this from outside the law school, follow this link and sign in using NetBadge: [http://search.lib.virginia.edu/catalog/u5221984](http://search.lib.virginia.edu/catalog/u5221984).

This edition of the *Slatebook* is keyed to the 20th edition of the *Bluebook*. That is the edition of the *Bluebook* you should use.
Part I: Virginia Law Review Conventions

In general, the Virginia Law Review follows the conventions outlined in the 20th edition of the Bluebook. This Part outlines where VLR conventions depart from the Bluebook, adds additional rules, and seeks to clarify some of the more obscure Bluebook rules. Where the Slatebook addresses a subject, the Slatebook governs. If a topic is not covered in the Slatebook, follow the Bluebook. If neither style guide addresses the issue, the Executive Editors will establish a rule. Executive Editors are also responsible for clarifying particularly complicated rules.

Because the Slatebook is designed principally to point out where VLR conventions differ from those of the Bluebook, it is essential to look at the Bluebook in all areas. In editing, you should

1. Look up the Bluebook rule for every citation. Citations often fool you into thinking they’re correct because they look correct, but you won’t be sure until you look it up!
2. Check the Slatebook for VLR conventions changing the Bluebook rule.

The Slatebook conventions in this Part are organized by the Bluebook rule to which they correspond (with a parenthetical indicating the page where each rule appears in the Bluebook).

Bluebook Rule 1.1: Citation Sentences and Clauses in Law Reviews (BB p. 57)

(a) Footnote Call Rules for Cases

When case names first appear in the main text, we require a footnote call immediately after the first sentence in which the case is mentioned. If, in the same textual sentence, there appears a quotation or other proposition for which the case is cited, be sure to include pinpoint citation information as well.

Ex. In Gorin v. Pong for PILA, the Supreme Court of Virginia held that t-shirts for entrants “justified the entry fee as a matter of law.”

\[1\] 543 S.E.2d 587, 597 (Va. 1997).

Exception: When more than one case is introduced in the same textual sentence, use “call cites” after the case names to provide the basic citation information for the individual cases.

Ex. Chief Justice Marshall gained notoriety with his majority opinions in Marbury v. Madison\[1\] and McCulloch v. Maryland\[2\].

\[1\] 5 U.S. (1 Cranch) 137 (1803).
\[2\] 17 U.S. (4 Wheat.) 316 (1819).

Exception: When the sentence asserts the author’s argument rather than the holding of the case, use a footnote call immediately after the case name.

Ex. The doctrine of judicial review pursuant to Marbury v. Madison\[1\] is long established, but I believe that the case was wrongly decided.

\[1\] 5 U.S. (1 Cranch) 137 (1803).

(b) Footnote Call Rules for Statutes

The rules for statutes mirror the rules for cases. When statutes are first named in the main text, put a footnote call immediately after the first sentence in which the statute appears.; this footnote (or “call
cite”) should provide a citation to the *entire* statute. The name of the statute should be given if the author is referencing the entire statute as opposed to a discrete section.

**Exception:** When multiple statutes are introduced in the same textual sentence, use “call cites” after each statute.

**Exception:** When a sentence asserts the author’s argument or other information attributable to a source other than the statute, use a footnote call directly after the statute.

Ex. Noted avian law scholar Lauren O’Leary lists the Migratory Bird Treaty Act,\(^1\) passed by Congress to implement treaties protecting migrating birds, as the most influential legislation passed by Congress in the twentieth century.\(^2\)


**Note:** The Departmental Editor (“DE”) may, after consultation with the author and XEs, remove statute call cites if

1. the textual discussion only discusses a case’s or book’s interpretation of the statute and
2. the statute is clearly cited within the source discussed by the author. Editorial-Board (“EB”) members can note if this might be appropriate, but the editor must substantiate and cite the statute at the initial edit and cite check stage.

Ex. The Gun-Free School Zones Act,\(^1\) invalidated in *United States v. Lopez* on Commerce Clause grounds, was intended to protect schoolchildren from gun-related violence.\(^2\)


Ex. *United States v. Lopez* held that the Gun-Free School Zones Act was an unconstitutional use of federal power to protect school children from gun-related violence.\(^1\)

\(^1\) *514 U.S. 549* (1995).

**Bluebook Rule 1.2: Introductory Signals (BB p. 58)**

(a) Parentheticals After Signals

Unlike the Bluebook, *VLR requires* parenthetical explanations after the following signals:

- See also
- Cf.
- Compare/with
- But cf.
- See generally

**Exception:** A parenthetical is not required if the author is referencing the same piece (that is, “supra” and “infra” citations to other parts of the same work).

Parentheticals are optional with all other signals.

(b) Signals as Verbs

Spell out signals when they are used as verbs. For example, “cf.” becomes “compare” and “e.g.” becomes “for example.” When used in this way, information that would normally be included as a parenthetical should be made part of the sentence itself.
For a more in-depth discussion of this issue, see, for example, Andrea Daley, Daley Meditation: A Guide to Maintaining Internal Happiness During a Cite Check, 101 Va. L. Rev. 1125 (2015).

**Bluebook Rule 1.3: Order of Signals (BB p. 60)**

(a) *Signals of the Same Basic Type* (per BB 1.2 categories)
String these together in one citation sentence, separated by semicolons.

(b) *Signals of Different Types*
Separate these by periods. Each category identified in BB 1.2 gets its own citation sentence.

(c) *Editing Tip*
Be sure that the signals are in the correct order within footnotes, as per the *Bluebook* rule.

**Bluebook Rule 1.4: Order of Authorities (BB p. 61)**

(a) *Books and Journals*
When the same author is cited for the same type of work, the order is determined by the alphabetical order of the title.


(b) *Cases*
If two or more cases were issued by the same court in the same year, organize them in alphabetical order, unless they appear in different volumes of the reporter.


(c) *Titles with Opening Articles*
When alphabetizing, disregard opening articles (“The” “A” “An”).

Ex. Legally Blonde, The Paper Chase, Rounders
NOT: Legally Blonde, Rounders, The Paper Chase

**Bluebook Rule 1.5: Parenthetical Information (BB p. 64)**

(a) *Explanatory Parentheticals*
This type of parenthetical must be:
- A quotation that is a complete sentence with a period or four period ellipsis at the end;
- A participle phrase that may include a quote with NO period or ellipsis at the end;
- A noun or noun phrase; or
- The word “same” or “similar” if the author has a long string citation and the first source after the signal has a full parenthetical.


Ex. Gretchen Jewell, The Virtues of Delivery, 89 Va. L. Rev. 320, 325 (2012) (“On the battlefield of page proofing, local restaurants that deliver are the brave soldiers who bring ammunition to the front lines.”).

(b) **Quotation Within a Parenthetical**
   When there is a quotation within a parenthetical, any parentheticals indicating emphasis, omission, alteration, or quoting or citing another source goes within it.

   Ex. Adam Sorensen, Breaking Bluebook, 88 Va. L. Rev. 320, 322 (2009) (“I am *totally* crushing this edit.” (emphasis added) (citation omitted)).

(c) **Editing Tip**
   It is important to remember to check the order of parentheticals, per *BB* 1(5)(b). Do not forget to note if the author is citing to a concurring or dissenting opinion.

**Bluebook Rule 2: Typefaces for Law Reviews (a.k.a. VLR Italicization Conventions) (*BB* p. 67)**

(a) **General Rule**
   The *Virginia Law Review* does not follow the elaborate typeface conventions of the *Bluebook*. Notwithstanding the use of typeface in the *Slatebook*, *VLR* abides by the following rules.

   **LARGE AND SMALL CAPITALS** are only used for Part headings. They are *never* used in citations. **Bold face** and **underlining** are *never* used.

   **Italicization** is only used in limited circumstances as described below.

(b) **Distinguishing Citations from Textual Material**
   It is important to understand the difference between a “citation” and “textual material” because *italics* are used differently in each.

   **Citation:** *Any reference in a footnote* that has a signal (or “no signal,” according to *BB* 1.2) followed by a source.

   **Textual Material:** Anything that is not a citation, whether it is in the footnotes, a parenthetical of a citation, or in the main text. Thus, case names that are themselves part of sentences are considered text, even in footnotes and parentheticals.

   In the following example, “Nerd Herd v. Act Like You’ve Been There” is a case name in a textual sentence (even though it is in a footnote) and is therefore italicized:


   In the next example, “Monaghan v. Sorensen” is a citation and is therefore *not* italicized. “Gorin v. Palmer,” however, is part of the parenthetical’s textual sentence and therefore *is* italicized.

   Ex. ² Monaghan v. Sorensen, 211 F.3d 372 (4th Cir. 2003) (rejecting an analogy to *Gorin v. Palmer*, 87 F.3d 372 (4th Cir. 1996)).

   **BUT** ² Monaghan v. Sorensen, 211 F.3d 372 (4th Cir. 2003) (quoting *Gorin v. Palmer*, 87 F.3d 372 (4th Cir. 1996)).
The second example differs because “quoting” and “citing” parentheticals are treated differently. The Bluebook does not treat case names in parentheticals following the words “quoting” and “citing”—when used by themselves—as being part of a textual sentence. See BB 10.6.2 (BB p. 108)

(c) *When Signals are Used as Verbs*

Italicize case names that follow a signal when the signal is used as a verb. Using a signal as a verb makes the case part of textual material. Using a signal as a signal makes the case part of a citation.

Compare: 6 For a more thorough analysis, see Monaghan v. Sorensen, 211 F.3d 372 (4th Cir. 2003).

With: 6 The Fourth Circuit provided a more thorough analysis in a recent case involving six authors, see Monaghan v. Sorensen, 211 F.3d 372 (4th Cir. 2003), when it found the previous precedent unpersuasive.

In the first example, “see” functions as a verb rather than a signal, making the case name part of a textual sentence. In the second example, “see” functions as a signal, making the case name a citation. To understand this distinction, refer to BB 1.2(e) (BB p. 60). While VLR does not italicize signals, BB 1.2(e) clarifies when signals are used as signals and when they are used as verbs. If the signal would be italicized under the Bluebook rule, then the case name following it is a citation and is not italicized under VLR convention. If the signal would not be italicized under the Bluebook rule, however, the case name following it is part of a textual sentence and must be italicized.

Note that these conventions only involve case names. These conventions do not apply to books, journals, newspapers, magazines, movies, plays, paintings, and continuing television series that follow signals used as a verb. If a law review article is mentioned, the journal’s name is italicized only if it is used independently from a citation. Thus:

Ex. For a better description of the distinction, see Andrea Daley, The Slatebook as Scripture, 95 Va. L. Rev. 1 (2010).

NOT: For yet another description of the distinction, see Ben Kuder, I Have Figured Out the Slatebook. Have You?, 95 Va. L. Rev. 1 (2010).

**Bluebook Rule 2.1: [Italicization in] Citations (BB p. 67)**

The following italicization rules apply exclusively to citations in footnotes. (Textual material in footnotes and the main text is governed by the next section.) If it is not discussed here and it is in a citation, it should not be italicized.

(a) *Case Names*

Never italicize case names when they are part of a full citation. This rule includes procedural phrases like “in re” and “ex rel."


Always italicize case names when used in a short citation.

Ex. 8 O’Leary, 30 F.2d at 46 (Desaulniers, J., concurring in part) (comparing the time spent preparing for the competition with time spent studying for school); In re Lystash, 1996 WL 118367, at *3 (linking the time spent preparing for the competition to health problems).
(b) **Words and Phrases**

Italicize the following words and phrases in citations:

(i) The phrase “___ in.” Examples include “reprinted in,” “quoted in,” “cited in,” and “in.”


(ii) The word “to” when citing to a preface, foreword, introduction, or epilogue by someone other than the author, according to BB 15.6.

Ex. 9 See Meredith Loretta, Introduction to Ollie Engebretson, To Bilt or Not To Bilt: Life as a Double Hoo (2007).

(iii) Words or phrases in the title of a book or an article that are italicized in the original.


**Bluebook Rule 2.2: [Italicization in] Textual Material** (BB p. 69)

Only the following should be italicized in textual material:

(a) **Case Names**

Italicize all case names in textual material.

Ex. The controlling precedent is Mitchell v. Two Unnamed Miami-Dade County Prosecutors,16 which denied standing to the third-party intervenor on a claim of malicious prosecution.

16 The court in Mitchell also denied Rule 11 sanctions, despite repeated contempt threats by the judge during the proceedings.

If “id.” refers to a case name in textual material, it should be italicized, as in the following example from textual material in a footnote:

Ex. These laws and the Supreme Court cases that upheld them are discussed in id.

(b) **Some Secondary Sources**

The names of books, journals, newspapers, magazines, movies, plays, paintings, and continuing television series when used independently from a citation (but not the name of particular articles, episodes of TV shows, or song names—they are simply capitalized).


(c) **Equations and Individual Letters**

Italicize all equations. For guidance on formatting equations see Chicago Manual of Style ¶ 12.21.

Ex. $e = mc^2$

Italicize all individual letters, when used to represent the names of hypothetical parties or places.

Ex. A formed a contract with B to purchase Blackacre, which is located in state X.

(d) **Words in Quotations or Titles**
Italicize words in quotations or titles that are italicized in the original source.

Ex. Gorin’s How Virginia Law Review Online is Changing Legal Scholarship has received widespread critical acclaim as a gut-wrenching, emotional rollercoaster ride.

Note, though, that words italicized in the original and italicized under one of the other Slatebook conventions should be in Roman, because the two italicizations cancel each other out.

(e) Words to be Emphasized
Italicize words the author wants to emphasize.

Editorial Board members should mark these for the Departmental Editor’s reference, and Departmental Editors should leave these notes for Executive Editors to review.

(f) Foreign Words
Italicize some foreign words. If the word is on the following list or is a variation of one of the words therein, it should be in ordinary roman type and NOT italicized:

<table>
<thead>
<tr>
<th>a fortiori</th>
<th>a posteriori</th>
<th>a priori</th>
</tr>
</thead>
<tbody>
<tr>
<td>amicus curiae</td>
<td>bona fide</td>
<td>Certiorari</td>
</tr>
<tr>
<td>de facto</td>
<td>de jure</td>
<td>de minimis</td>
</tr>
<tr>
<td>Dictum</td>
<td>ex ante</td>
<td>ex post</td>
</tr>
<tr>
<td>inter alia</td>
<td>mens rea</td>
<td>per curiam</td>
</tr>
<tr>
<td>per se</td>
<td>prima facie</td>
<td>quasi-</td>
</tr>
<tr>
<td>res ipsa loquitur</td>
<td>Sic</td>
<td>stare decisis</td>
</tr>
</tbody>
</table>

If the word is NOT listed in BB 7, on the above list, or a variation of a word on the above list, leave it (italicized or not) as the author put it, and the XEs will make a final decision.

(g) Ship Names
Italicize the names of ships.

Ex. Mildred chided Francis for naming his new speedboat the S.S. Boaty Call.

Bluebook Rule 4.2(a): “Supra” (BB p. 80)
When “supra” is used to refer to a different part of a source, the citation should include all relevant information, such as the volume number of the work, not just the information that differs from the original citation.


Bluebook Rule 4.2(b): “Hereinafter.” (BB p. 80)
“Hereinafter” is generally only used when the same author is cited multiple times in the same footnote or when the shortened form would be confusing.

VLR also allows “hereinafter” when multiple pieces by the same author are cited extensively throughout the text, even if the original citations are in different footnotes.
Note that the shortened form should appear in the same typeface used in the full citation.


**Bluebook Rule 5.1: Formatting of Quotations (BB p. 82)**

(a) **General Rule**

Follow the Bluebook. Do not assume that you already know the rules.

(b) **Editing Procedure**

Leave a comment after every quote indicating the number of words in the quote. If a quote has fifty or more words, follow BB 5.1(a). If a quote has forty-nine or fewer words, follow BB 5.1(b).

(c) **Quotes of Fifty or More Words**

A quote with fifty or more words must be reformatted as a block quote according to BB 5.1(a).

- Delete the beginning and end quotation marks.
- Quotation marks within the quote should appear as they do in the source.
- You must check to see if the quote is the start of a paragraph in the original source. If it is, indent the first line of the block quote. If it is not, do not indent it. Either way, note it for the DE— {DE: block quote does/does not begin a new paragraph}.

This also applies to quotes of fifty words or more that appear in footnote text.

This rule does not apply to quotes of fifty words or more that appear in a citation parenthetical.

(d) **Quotes in Parentheticals**

All quotes in a parenthetical are enclosed in quotation marks and are not otherwise set off from the rest of the text, regardless of length.

**Bluebook Rule 5.2: Alterations and Quotations Within Quotations (BB p. 83)**

(a) **Archaic Spelling or Capitalization**

Do not change archaic capitalization or spelling within a quote unless it would significantly improve understanding (in which case, indicate any alterations with square brackets as outlined in BB 5.2).

(b) **Additional Parentheticals Due to Alternations**

Use a parenthetical clause after the citation to indicate when any of the following alterations are made to the original source quoted: (i) addition or omission of emphasis, (ii) any alteration to the original, (iii) omission of citations, (iv) omission of footnote call numbers, or (v) omission of internal quotation marks. Follow BB Rule 1.5(b) regarding order of parentheticals.

Pay careful attention to whether a quote requires the addition of parentheticals to the citation. If the author adds emphasis, there must be an “emphasis added” parenthetical. If bracketed language appears in the original source, there must be an “alteration in original” parenthetical, and so on for other alterations.
This rule applies to quotations within parentheticals as well. If a quotation parenthetical itself requires an explanatory parenthetical, the explanatory parenthetical should be nested within the quotation parenthetical.

(c) Internal Quotation Marks (BB Rule 5.2(f))

Any time the quoted source is itself quoting a second-order source, this should be indicated with a “quoting” parenthetical. Do not fail to include a “quoting” parenthetical even when internal quotation marks are omitted under the rule below.

Retain any quotation marks internal to the first-order source you are quoting. The only time it is acceptable to omit quotation marks is when the second-order quotation is coextensive with the portion of the material you are quoting from the first-order source (the opening mark appears at the very beginning of the in-line quotation and the closing mark appears at the very end). This should be indicated by inclusion of an “internal quotation marks omitted” parenthetical immediately following the “quoting” parenthetical. This parenthetical is only appropriate when omitting quotation marks under this rule, as shown in the example below.

Ex. Text in Danielle’s Book: As Emily Reeder always says, no day is complete without “at least one video of baby animals.”

YES: Danielle argued that “no day is complete without ‘at least one video of baby animals.’”
YES: Danielle argued that everyone should watch “at least one video of baby animals” every day.
NOT: Danielle argued that everyone should watch “at least one video of baby animals” every day.

1 Danielle Desaulniers, The Importance of Cat Videos 3 (2016) (quoting Emily Reeder, All the 1Ls Hate Me 76 (2016)).
2 Danielle Desaulniers, The Importance of Cat Videos 3 (2016) (quoting Emily Reeder, All the 1Ls Hate Me 76 (2016)) (internal quotation marks omitted).

(d) Citations Omitted (BB Rule 5.3(c))

When a quote omits a citation contained in the original source, this should be indicated with a “citation omitted” parenthetical. No ellipsis is necessary if the citation is the only thing omitted. Note that there is no such thing as a parenthetical that reads “internal citation omitted.”

Ex. Original case: Some commentators were skeptical that the Hoos could win the national championship. See, e.g., Dick Vitale, Defense Can’t Win the Big Dance, 25 Bracketology L.J. 1, 4 (2016). We never doubted them.

Quote in Article: The Fourth Circuit displayed its support for UVA, stating: “Some commentators were skeptical that the Hoos could win the national championship. We never doubted them.”

YES: 1 Brogdon v. Williams, 800 F.3d 1, 14 (4th Cir. 2016) (citation omitted).
NOT: 1 Brogdon v. Williams, 800 F.3d 1, 14 (4th Cir. 2016) (internal citation omitted).

Bluebook Rule 5.3: Omissions and Ellipses in Quotations (BB p. 85)

(a) General Rule

Pay extra attention to ellipses. It is very important that ellipses are done correctly at the initial edit and cite check stages. If you are not sure how a rule applies, any of the Executive Editors are more than happy to help.

Read the Bluebook rules carefully, then follow this process:
(i) **Use nonbreaking spaces when inserting ellipses.**
There needs to be a nonbreaking space between the word immediately preceding the ellipsis and the first period of the ellipsis, as well as nonbreaking spaces between each period of the ellipsis. A nonbreaking space should also be inserted between the last period of the ellipsis and the next word if the ellipsis occurs midsentence.

An ellipsis should never be partially on one line and partially on the next, nor should it be at the end of a line if the ellipsis occurs midsentence. PC users can insert a nonbreaking space by pressing CTRL + SHIFT + SPACEBAR. Mac users can insert a nonbreaking space by pressing OPTION + SHIFT + SPACEBAR.

(ii) Determine if the quotation is being used as a phrase or as a full sentence and follow the corresponding rules below.

(b) **Quotation Used as a Phrase**
Omitted material within a phrase should be represented with an ellipsis (three periods separated by non-breaking spaces). See example in *BB 5.3(a).*

Punctuation within the omitted material is not indicated, but note if there is a comma immediately before or after the omitted material.

When a quote is used as a phrase, there will *never* be an ellipsis for omitted material at the beginning or at the end of the phrase. Only use an ellipsis to indicate omission of matters *within* the phrase quoted.

Ex.  Ben Kuder, a renowned expert on ellipses, “never forgets a nonbreaking space.”  
NOT: Ben Kuder, a renowned expert on ellipses, “never forgets a nonbreaking space . . . .”

(c) **Quotation Used as a Full Sentence**
Compare the original source and the quotation in the piece to determine where the material is omitted. The material will be omitted from one of five places:

(i) **Beginning of the sentence.** See example in *BB 5.3(b)(i).*  
Do not use ellipses. If the first word is not capitalized in the original, capitalize the first letter and put it in brackets. The only time it is appropriate to begin a sentence with an ellipsis is when the first part of a new paragraph in a multi-paragraph quotation is omitted. See example in *BB 5.1(a)(iii).*

(ii) **Middle of a single sentence.** See example in *BB 5.3(b)(ii).*  
Use a three-period ellipsis with nonbreaking spaces.

(iii) **End of the sentence.** See example in *BB 5.3(b)(iii).*  
When the material immediately preceding the final punctuation is omitted, put a nonbreaking space after the final quoted word, followed by a three-period ellipsis, and then a nonbreaking space and the final punctuation.

(iv) **After the end of the sentence and followed by further quotation.** Example in *BB 5.3(b)(v).*  
If a sentence ends, but there is more quoted material after the end of the sentence, include the final punctuation and then an ellipsis. There should be no space between the last word and the final punctuation.
Do not use ellipses if the end of the sentence is also the end of the quote. See example in \textit{BB} 5.3(b)(iv).

(v) \textbf{At the end of the sentence and after the end of the sentence.} See example in \textit{BB} 5.3(b)(vi). Use a four-period ellipsis. There should be a nonbreaking space between the last word and the first period of the ellipsis and a nonbreaking space between the last period of the ellipsis and the first word of the next part of the quote.

\textbf{Bluebook Rule 6.1: Abbreviations} (\textit{BB} p. 87)

(a) \textbf{General Rule}

Always use quotation marks within parentheses to identify an abbreviation on its first reference in the piece.

\begin{quote}
Ex. Food and Drug Administration (“FDA”)
\end{quote}

If the abbreviated term is first used in a footnote that precedes the first reference in the main text, introduce the abbreviation a second time at the first main text reference.

(b) \textbf{Periods and Spacing}

Follow \textit{BB} Rule 6.1(a). Close up the spaces between adjacent single capitals in abbreviations, including when the abbreviations form part of a person’s name.

\begin{quote}
Ex. The XEs were disappointed when Devon’s paper about H.L.A. Hart failed to follow the \textit{Slatebook} rules.
\end{quote}

(c) \textbf{Organizational Names}

Note the \textit{Bluebook} rule provides that organizational names may be abbreviated without periods only when the entities \textit{“are commonly referred to in spoken language by their initials rather than their full names.”} Thus “CIA” and “NASA” are acceptable without periods, but the Western District of Virginia must be abbreviated “W.D. Va.”

(d) \textbf{Political Entities} (for example, “United States”)

Use periods when abbreviating the names of all political entities (for example, the U.S., U.N., the E.U., and N.Y.). Such abbreviations may only be used as adjectives; the abbreviations cannot be used as nouns.

\begin{quote}
Ex. The European Union announced a new trade agreement on Thursday.
The E.U. trade agreement provides penalties for exporting sheep.
\end{quote}

“United States” is never abbreviated in a case name where the United States is a party.

\textbf{Bluebook Rule 6.2: Numerals and Symbols} (\textit{BB} p. 88)

(a) \textbf{Numerals}

Follow the \textit{Bluebook} rules for deciding whether a number should be spelled out or written as a numeral (Rule 6.2(a), \textit{BB} p. 88), and for the use of dollar and percent symbols (Rule 6.2(d), \textit{BB} p. 89).

(i) \textbf{Percentages or Dollar Amounts}

When a Section contains numerous references to percentages or dollar amounts, numerals should be used consistently for all percentages or amounts. See \textit{BB} 6.2(a)(v).
Ex. Ollie was willing to pay $200 for tickets to see Carly Rae Jepsen in concert, but ended up finding them for $50.

(ii) **Repeated Use of Numbers**

When a Section or an Article contains numerous references to other types of numbers (for example, a piece relying heavily on statistics), numerals may be used for all numbers. Editorial Board members should flag these areas and the DEs and XEs will make a final determination.

(iii) **Exception: Court and Legislative Votes**

When indicating the number of votes received for a court’s opinion or piece of legislation, use the numerals separated by a hyphen.

Ex. In *Trueba v. Heller*, the Court stunningly voted 9-0 that the Miami Heat, rather than the Los Angeles Lakers, is America’s favorite team.

Ex. The Virginia House of Delegates rejected the bill to make Dandelion a state holiday by a vote of 51-49.

(iv) **Exception: Four Digit Numbers**

When a four-digit number that is not a year appears in textual material, insert a comma. However, follow the *Bluebook* rule when four-digit numbers appear in citations (Rule 6.2(a)(vii), *BB* p. 89).

Ex. The Empire State Building was completed in 1931, and it is 1,454 feet tall.

(v) **Exception: Section Numbers**

Notwithstanding *BB* Rule 6.2(a)(vi), you may write out a section or subdivision number if the number is less than 10.

Ex. Congress passed the law under its Section Five powers.

(b) **Symbols**

*VLR* convention differs slightly from the *Bluebook* in its treatment of section (§) and paragraph (¶) symbols (*BB* p. 89).

(i) **Main Text**

In the main text, spell out and capitalize the words “Section” and “Paragraph” when referring to a specific part of a code or statute. When the main text provides a full reference to the statute, use the section symbol and numerals.

Ex. The case was filed under Section 1983.
Ex. The case was filed under 42 U.S.C. § 1983.

(ii) **Footnote Text**

In footnote text and citations, the § or ¶ symbols should always be used, except at the beginning of sentences (where the word must be spelled out). When using a symbol, there must be a nonbreaking space between the symbol and the number.

Ex. The case was filed under § 1983.
Bluebook Rule 8: Capitalization (BB p. 91)

(a) General Rule

VLR follows all of the capitalization rules in this section of the Bluebook for English-language titles.

Particularly note the treatment of “Commonwealth,” “State,” “Federal,” “the President” (as used to refer to the office), and “Justices” (as used to refer to members of the U.S. Supreme Court generally); mistakes are frequently made with these words. For capitalization of foreign-language titles, see the Slatebook entry or BB Rule 20.

(b) Supplemental Rules

(i) The terms Article, Essay, Book Review, Note, and so on when used to refer to the piece itself. The terms should not be capitalized when used to refer to another work.

(ii) Subdivision terms such as Part and Section should be capitalized when used to refer to the piece itself. They should not be capitalized when used to refer to subdivisions of another work.

Ex. The fourth Part of this Article reviews a study Amanda Leon commissioned to determine the relationship between creative dance moves and the likelihood of future success as a lawyer.

(iii) Do not capitalize “constitutional,” “governmental,” “congressional,” “presidential,” and similar adjectives.

(iv) Do not capitalize “government.” Do capitalize “State” and “Commonwealth” when used to refer to litigants in a suit.

(v) Do not capitalize “executive branch.” Executive may be capitalized when referring to a specific executive, but the branch should not be.

(vi) Do not capitalize doctrines like “substantive due process.” Do capitalize specific clauses of and amendments to the U.S. Constitution—for example, “Commerce Clause,” “Due Process Clause,” and “First Amendment.” Do capitalize “Clause” and “Amendment” whenever the Author is clearly referring to a specific clause or amendment, even if it is not named in full in that particular statement.

Ex. According to the Court’s interpretation of the First Amendment, Lizzie is free to refer to professors as “bananas.” The Amendment protects her right to speak even when others might disagree.

(vii) Do capitalize references to foreign political units that are capitalized in the native language. For example, “several German Lander.”

(viii) Do capitalize “Founding” and “Framing.” “Founding-era” or “Framing-era,” if used as an adjective, are hyphenated.

(ix) Do capitalize “Act” when referring to a specific statute. Do capitalize “Title,” “Section,” and “Paragraph” when referring to a specific title, section, or paragraph of a code or statute.
Ex. Dean Mahoney insists that the Securities Exchange Act of 1934 is fascinating, but Andrea would choose a different word to describe the Act.

(x) **Do** capitalize “Internet,” whether used as an adjective or a noun as per *Chicago Manual of Style* ¶ 7.76.

(xi) Capitalization of words in the titles of books, articles, and similar materials should follow the *Bluebook* rule, even if the original uses a different capitalization rule (or no rule at all). In short, capitalize the first letter of every word in the title, except for prepositions, articles, and conjunctions of four or fewer letters (which should begin with lowercase letters). Always capitalize the first letter of the first word of any title and the first letter of the first word after a colon.

(xii) Capitalize the word “judge” and related judicial titles only when the title accompanies a proper name (but always capitalize “Justice” when referring to a U.S. Supreme Court Justice).

Ex. During his tenure on the chancery court, Vice Chancellor Gruetzmacher’s hair grayed significantly.

Ex. Fearing that his opinion lacked a sufficient number of esoteric words, the vice chancellor instructed his law clerk to grab a thesaurus and “go to town.”

(xiii) Only capitalize terms with cultural significance if the sentence makes specific reference to the cultural, historical, or literary reference point.

Ex. Botox is a fountain of youth for those with unfortunate facial creases.

Ex. The search for anti-aging creams in cosmetic stores is in many ways akin to Ponce de Leon’s fabled search for the Fountain of Youth.

*Bluebook* Rule 9: Names of Courts, Judges, and Professors (*BB* p. 94)

(a) **Judges and Justices**

The *Bluebook* rule requires use of the titles “Judge,” “Justice,” “Chief Judge,” and “Chief Justice.” Add the appropriate title whenever a judge or justice is mentioned in the text. If a piece makes frequent reference to historical figures who were judges, the title may be dropped after the first reference if repeated use becomes awkward. When used as a modifier (for example, the Warren Court), no title is required.

(b) **Professors**

*Student authors* should always use the honorific title “Professor” when they refer to any individual professor for the first time in their notes or comments. *Other authors* are encouraged to use it. Editorial Board members should add the honorific title at the first reference if the biographic material for the source’s author indicates that is appropriate. Most importantly, be sure that this title is used consistently (either give all professors a title, or don’t use the title at all). If the title is first given in a footnote, use it again at the first appearance above the line.

(c) **Previous Jobs/Positions**

Indicate, by reference to the former title, when a justice, judge, or other person is mentioned in regard to his or her previous position.

Ex. As then-Judge Ruth Bader Ginsburg wrote, “lace collars are always in style.”
(d) **Courts**

Give the full name of a court the first time that court is mentioned in the text, but abbreviate “United States.” If the first textual reference to a court occurs in a footnote before the first reference in the main text, use the full name in both instances.

Ex. The U.S. District Court for the Western District of Virginia dismissed the Harvard Law Review’s complaint for failure to state a claim.

Ex. The U.S. Court of Appeals for the Fourth Circuit affirmed.

Subsequent mentions of the same court may be shortened. For these purposes, the first mention of any one circuit court or district court is considered to be the first reference for all subsequent circuit courts or district courts. For example, following a first reference to the U.S. Court of Appeals for the Fourth Circuit, it would be acceptable to say “the Third Circuit” the first time that court is mentioned.

**Bluebook Rule 10: Cases (BB p. 94)**

(a) **General Rule**

The rules in the Bluebook govern.

(b) **Abbreviations**

Check every word in a case name against T6 and T10 to see if it should be abbreviated. The words in T6 and T10 are only abbreviated in citations. They are not abbreviated in textual material, including parentheticals.

Ex. See Jewell v. Univ. of Va., 12 F. Supp. 2d 93, 99 (W.D. Va. 2013) (distinguishing the holding of Corcoran v. University of Virginia, and holding that some students manage to graduate law school with their souls intact).

**Bluebook Rule 10.2.1(h): Business Firm Designations (BB p. 100)**

As the Bluebook rule states, omit “Inc.,” “Ltd.,” “N.A.,” “F.S.B.,” and similar terms if the name of a party also contains words such as “Ass’n,” “Bros.,” “Co.,” “Corp.,” “Ry.,” and “R.R.” that clearly indicate that the party is a business firm.

Additionally, omit “Inc.” and “Ltd.” even where they are the only business designations, whenever the name of the party itself clearly indicates that it is a business.


“Inc.” and “Ltd.” are always retained with one-word business firm names, because, in theory, the one word might be a party’s last name.

Ex. Microsoft Corp. v. Suellentrop’s, Inc.

NOT: Microsoft v. Suellentrop’s


**Bluebook Rule 10.2.2: Additional Rules for Case Names in Citations (BB p. 101)**

If the reporter is incorrect concerning the party name, it is appropriate to correct the case name. For instance, if the reporter omits a comma between a name and “Inc.” and the company retains it, it is appropriate to insert the comma.
Bluebook Rule 10.3.2: Reporters (BB p. 103)
Use nonbreaking spaces in reporter names. For example, insert a nonbreaking space between “F” and “S” when citing to F. Supp.

Bluebook Rule 10.6.1 Parenthetical Information Regarding Cases: Weight of Authority (BB p. 107)
(a) General Rule
Follow the Bluebook rule, with the following additions regarding concurrences and dissents.

(b) Judges Joining an Opinion
VLR generally only includes the name of the judge or justice who wrote the dissenting or concurring opinion, but in some cases the names of those who joined the opinion are particularly important to the author’s point. In that case, the author of the opinion should be first; the order of those who joined the opinion should follow as listed in the case:


(c) Alternate Descriptions
When the text of the opinion itself does not say whether the opinion is a concurrence or a dissent, use the same format cited above, but retain the description used in the opinion. These alternate descriptions are most likely to appear in citations to foreign courts.

Ex. 9 O’Leary v. Douglas (2016) SCLR 852 (Scot.) (Pare, J., separate opinion).
10 Otis v. Leon 2014 (3) SA 22 (CC) (S. Afr.) (Burke, J., statement).

Bluebook Rule 10.6.3 Parenthetical Information Regarding Cases: Order of Parentheticals (BB p. 108)
Note the special placement of parentheticals when the explanatory parenthetical itself requires a “quoting” or “citing” parenthetical.

Bluebook Rule 10.7: Prior and Subsequent History (BB p. 109)
Do not italicize phrases dealing with subsequent and prior histories. “Cert. denied” indicates nothing, and should be avoided absent compelling rationale. In all other respects, the Bluebook rule governs.

Bluebook Rule 10.8.3: Briefs, Court Filings, and Transcripts (BB p. 113)
The Bluebook rules govern. Note that the format of the date and the placement of the docket number depend on whether a decision has been rendered on the filing cited.

Ex. Where no decision has been rendered:

Ex. Where a decision has been rendered:

Bluebook Rule 10.9: Short Forms for Cases (BB p. 115)
(a) General Rule
Although the Bluebook offers a choice of short forms, VLR generally uses:

Trombley-Shapiro Jonas, 480 U.S. at 170.

VLR also allows for the “480 U.S. at 170” form if the case name is already mentioned in the textual sentence for which the short form is providing support.
Ex. 15 In a later section of Trombley-Shapiro Jonas, the Court examined whether there was a limit on the number of last names a person could have. Although declining to impose a maximum number allowed, the Court concluded that three last names was quite a lot. 480 U.S. at 170.

Id., of course, must be used where applicable under Rule 4.1 (BB p. 78).

(b) When to Use the Short Form

(i) Above the Line
In the main text, use a case’s shortened name (generally, the name of one of the parties) only when the case has already been named in full in the main text of the same Part.

Ex. II. THE SUPREME COURT’S APPROACH
The Court in Monaghan v. Sorensen attempted to resolve the conflict among the various circuits.3

A. Criticisms and Commentators
Many scholars have questioned the Court’s reasons for granting certiorari in Monaghan.

III. NEW DIRECTIONS
It is uncertain whether the Monaghan v. Sorensen approach will be followed in the future.24

(ii) Footnotes
Use a shortened name or a short form citation only if the case has been either:

(1) previously named in the main text of the Part in which the footnote appears, or
(2) named or cited within the preceding five footnotes.

(c) Exception for Conclusion
All case names that appear anywhere in the main text may be short-cited in the conclusion.

(d) Exception for Cases that are the Focus of the Piece
All cases that are the focus of the piece should be short-cited throughout after the first reference in the main text. The DE will indicate whether a case warrants “focus of the piece” status in the initial DE memorandum.

Bluebook Rule 11: Constitutions (BB p. 118)
When citing state constitutions, the numbering system that the state uses for its constitution must be followed. It is not appropriate, if citing multiple state constitutions, to change the numbering systems for consistency.

Bluebook Rule 12.3: Statutes: Current Official and Unofficial Codes (BB p. 123)
As the Bluebook states, “Cite to the official code whenever possible.”

For federal laws, cite to the U.S.C. unless the law is too recent to have been codified there. For state laws, cite to the state code in the law library (though this code often is not the official code).

If available, citations to the U.S.C. should be to the 2012 version (ex. 32 U.S.C. § 1331 (2012)).

Always check the code’s supplement. For federal laws enacted after 2006, cite to the U.S.C.’s annual supplement, if therein; otherwise, cite to an unofficial code. Legislators have joined in a dark, cabalistic conspiracy to amend and repeal laws on a regular basis. Your law may be next.
Bluebook Rule 12.6: Statutes: Other Secondary Sources (BB p. 127)
Be aware that U.S.C.C.A.N., which is mentioned in this rule and in rule 13.4, was, in an earlier incarnation, the U.S. Congressional Service. Make sure that you check the volume’s spine carefully to ensure that the citation is to the correct name. Otherwise, follow the rule.

Bluebook Rule 12.7: Statutes: Invalidation, Repeal, Amendment, and Prior History (BB p. 128)
When the author cites an early version of a law that has later been amended or repealed, this later history should be included in the citation. This means that most citations to statutes must be checked for subsequent history. Laws passed before 1900 (most notably the Judiciary Act of 1789) are exempt from this rule unless the subsequent history is relevant to the author’s point.

Bluebook Rule 12.9.1: Special Citation Forms: Internal Revenue Code (BB p. 129)
The Bluebook suggests that in citations to the Internal Revenue Code, one “may” replace “26 U.S.C.” with “I.R.C.” Either way, the piece should consistently use one or the other.

Bluebook Rule 12.10: Short Forms for Statutes (BB p. 133)
(a) General Rule
Follow the short forms indicated in the Bluebook.

(b) Exception for U.S. Code
U.S. Code provisions may be shortened simply to their section number (for example, “Section 1983” or “§ 1983”), as long as the title number and code are clear by context.

(c) Abbreviating “Section”
Remember that the word “Section” should be abbreviated to “§” in footnote citations and footnote text (Slatebook Rule 6.2).

Bluebook Rule 13.3: Legislative Materials: Hearings (BB p. 137)
As suggested by the Bluebook examples, always identify the speaker for any citation to a hearing.


Bluebook Rule 13.5: Legislative Materials: Debates (BB p. 140)
As with hearings, always identify the speaker for any citation to a debate. VLR makes an exception to the order of authorities rules in debate citations. The Bluebook calls for such material to be cited in reverse chronological order, and if the author wants it that way, it is fine to leave it, but the preferred order for VLR is chronological (which is the same as sequential page order).

Ex. 156 Cong. Rec. 6089 (2014) (statement of Sen. Lystash); id. at 9479 (statement of Sen. Manns); id. at 13,766 (statement of Sen. ScheerCook).

Bluebook Rule 14: Administrative and Executive Materials (BB p. 143)
(a) Editing Tip
Keep in mind that citation rules for many Federal Administrative and Executive Materials, like, Attorney General Opinions, Treasury Regulations, and Executive Orders, are found in T1 (starting at p. 233).

(b) Sources Not in the Bluebook
If you encounter a source that does not correspond to any of the documents in the Bluebook, give it your best shot, and remember that the point of a citation is to enable a reader to find the original source. When in doubt, include more helpful information rather than less.

(c) Executive Orders
For Executive Orders, note C.F.R. does not have a section sign, and the year of the volume is listed. Include the “reprinted as amended” if possible, but do not italicize it.


Bluebook Rule 14.2: Rules, Regulations, and Other Publications (BB p. 143)

(a) Federal Register Materials
In addition to the “final rules” and “proposed rules” discussed by the Bluebook in Rule 14.2, many other things are published in the Federal Register.

Cite those items by title (even if very long), followed by the regular Federal Register citation information shown in BB Rule 14.2.


(b) Comments and Letters
Individuals and entities that may be affected by a proposed administrative rule often submit comments and letters to the agency for consideration during the rulemaking process. The agencies generally keep the materials on file under a specific docket number. These comments and letters are unpublished, so copies should be obtained from the author or agency to keep on file at the VLR office.

Some agencies also make comments available online, in which case the URL should follow directly at the end of the citation (BB 18.2.2). In the past, we have cited such materials in accordance with the following examples.


Bluebook Rule 15.3: Books, Reports, and Nonperiodic Materials: Title (BB p. 151)
Include the entire title of the book even if it is long and full of commas. If it is cited more than once, feel free to use “hereinafter.” If a book title is too long and needs to be shortened, the XEs will do so.

Ex. 24 Kevin Palmer, The Art of Stealing, When Proper, For Professionals, Such as Doctors, Teachers, Statesmen, Generals, Barbers, Soldiers, Coopers, Blacksmiths, Engineers, Tanners, Gravediggers, and Midwives 310 (1904) [hereinafter Palmer, The Art of Stealing].

37 Palmer, The Art of Stealing, supra note 24, at 357.
Bluebook Rule 15.3: Books, Reports, and Nonperiodic Materials: Edition, Publisher, and Date (BB p. 152)
Follow the Bluebook. If the author cites to a pre-1900 work, follow BB 15.4(c) as explained below.

Note that there is always a comma after the abbreviation of “editor” to “ed.,” but never a comma after the abbreviation of “edition” to “ed.”

There will normally be only two situations where a work’s publisher will need to be cited: a work that has been published by someone other than the original publisher per BB 15.4(a)(iii) and works published before 1900 per BB 15.4(c).


Bluebook Rule 15.5: Shorter Works in Collection (BB p. 153)
Always indicate the page on which a shorter work in a collection begins the first time you cite it. If citing to the first page, give the number twice.

Ex. Emily Reeder, Joe Biden Posters and Cat Pictures, in How to Decorate Your Office 251, 251 (Marc Nowak ed., 2016).

Bluebook Rule 15.10.1: Short Forms for Shorter Works in Collection (BB p. 157)
Remember to use supra appropriately as described in BB 4.2.

If a shorter work in a collection has been cited previously, only supra to the shorter work; no further supra is necessary for the collection.


26 Douglas, supra note 24, at 32.

If the collection has been cited previously, but a particular shorter work in the collection has not, use the supra for the earlier cite to the collection.

Ex. 23 See generally Carefully Thought-Out But Questionable Choices (Lauren O’Leary ed., 2014).


Bluebook Rule 16: Periodical Materials (BB p. 159)
(a) Pincites
Always indicate the page on which a periodical article begins the first time you cite it. If citing to that page, give the number twice. Newspapers have a unique page number rule, however, so look to BB 16.6 for guidance when citing them.

(b) Abbreviations
Always refer to BB T10 and T13 when abbreviating periodical names. Use T10 to abbreviate geographic terms. T13.1 provides abbreviations for certain institutions, such as universities and
professional organizations. **T13.2** provides abbreviations for other common words. When abbreviating common words in periodical names per **T13.2**, incorporate the rule from **T6** regarding formation of plurals (unless otherwise indicated in **T6**, form plurals by adding the letter “s”).

For convenience, you may refer to the version of T13 from the 19th edition of the *Bluebook* attached as Appendix I, which provides abbreviated versions of particular periodical titles.

**Bluebook Rule 16.4: Consecutively Paginated Journals and Magazines (BB p. 162)**

(a) **General Rule**

Follow this rule for works found within periodicals that are consecutively paginated throughout an entire volume (like most law review articles).

(b) **Multiple Years**

Some PDFs on HeinOnline contain a two-year date span. Please refer to the article’s title page (or the issue in which the article appears) to determine the article’s actual year of publication.

(c) **Special Rule Regarding Years**

Note that the rule for journals that use the year as the volume number is to omit the year in the parenthetical, but BYU does not follow this rule.


**Bluebook Rule 16.5: Nonconsecutively Paginated Journals and Magazines (BB p. 162)**

Watch for journals that are separately paginated within each issue. Cite them appropriately under the rule.

(a) **Special Rule: American Economic Review**

There is one perennial problem of which you should be aware: The *American Economic Review*, which is published in standard paginated volumes, has a separate annual issue—typically, and confusingly, bound in the regular volumes—containing their Papers and Proceedings. We generally cite it:


(b) **Special Rule: Justice System Journal**

Additionally, there exists at least one journal (the *Justice System Journal*) which is separately paginated but, oddly enough, does not have any date indication other than the year—just the volume and issue numbers. We cite it:


**Bluebook Rule 17: Unpublished and Forthcoming Sources (BB p. 172)**

(a) **General Rule**

Bring unpublished and forthcoming sources to the attention of your Department Editor. DEs will try to get oral permission from authors of unpublished sources to cite or quote the source. Also, DEs will contact the journals publishing forthcoming materials to ask for the correct citation information or copies of the article. (The DEs will continue to check for this information, if necessary, up to the time the pages are sent to the printer.)

When unpublished materials are cited, provide a parenthetical that explains where the source can be found. Many unpublished materials are now available on the Internet, so citations to a URL are preferable. If *VLR* must keep a source on file, indicate this to the Department Editor, and the
explanatory parenthetical should be “(on file with the Virginia Law Review Association)”. “Virginia Law Review Association” is not italicized. It refers to the corporation, not the journal itself.

(b) Sample Citation Forms

(i) Manuscript on File


(ii) Manuscript Available on the Internet


(iii) Manuscript Available on SSRN

SSRN, the Social Sciences Research Network, is an Internet database commonly used by law professors to circulate drafts for commentary. When a cite to SSRN is used, the URL must be manually shortened to http://ssrn.com/abstract=XXXXXX


(iv) Letter


(v) Forthcoming Publication


(vi) Working Paper

Per BB 17.4, the only unpublished materials that should be cited as working papers are those that are designated and numbered as such by an institution. Commonly, authors may title their drafts as working papers, but these are cited as manuscripts under BB 17.2.1.


Bluebook Rule 18.2.1: Internet Citations (BB p. 180)

(a) General Rule

If a source available online could be fully cited according to another rule in The Bluebook, the citation should be made as if to the traditional source, with the URL appended directly to the end of the citation. It is no longer necessary to include “available at” before the URL under any circumstances.

The example below illustrates this in the context of a press release accessed online; it is cited consistent with BB Rule 17.2.3 regarding press releases, with the URL attached directly to the end.
These citations are direct citations to Internet sources, rather than parallel citations. When substantiating such citations, **Editorial-Board members are not required to find the traditional sources** (such as newspapers or magazines), but may include just the Internet version in the consolidated PDFs. However, if the author is only citing to the traditional form of a source such as a newspaper or magazine and not providing an Internet citation, Ed-Board members must still make every effort to find the traditional source.

(b) **Archival (BB p. 181)**

If a source is being archived by the *Virginia Law Review* using a permalink, the structure of the citation should follow BB Rule 18.2.1(d).


Take note of the order of parentheticals when citing online sources with URLs. See BB p.181.

**Bluebook Rule 18.2.2: Direct Citations to Internet Sources (BB p. 182)**

(a) **General Rule**

Sources that are available only on the Internet should be cited according to BB 18.2.2. Provide information about (a) the author of the page, (b) main page title, (c) date/time and, (d) URL according to the Bluebook rule.

(b) **Authors**

If no author is credited, provide the name of the institutional owner of the page (abbreviated per T6 and T10), if available. If no institutional owner information is available, or if domain ownership is clear from the main title of the website, you may omit an author name and begin the citation with the title of the article. The main page title of the website should still be included.


(c) **Page Titles**

Per BB Rule 18.2.2(b)(i), the main page title of the Internet source should be abbreviated using the common abbreviations found in T10 and T13.


If the URLs for websites run onto multiple lines, producing hideous spacing, please notify the Executive Editors via an “{XE: URL formatting}” comment.


Citations to foreign materials are governed by BB 20, which contains general rules, and Table T2 (BB p. 307), which contains country-specific information. Where these conflict, follow Table T2 as closely as possible. Do not forget that some foreign cases can be cited in a short form where appropriate (BB 20.7).

When citing foreign materials that are not in English, follow BB 20.2. The capitalization rule for non-English titles, BB 20.2.2(b), is a deviation from the general *VLR* capitalization rule.
**Bluebook Rule 21: International Materials** *(BB p. 200)*

*Bluebook* Rule 21 covers citations to international materials, but also check Table T3 *(BB p. 491)* for materials from intergovernmental organizations and Table T4 *(BB p. 494)* for treaty sources.

**Bluebook Rule 21.5.2: European Union Courts** *(BB p. 209)*

When citing an E.U. court decision, cite to the *Report of Cases Before the Court of Justice of the European Communities* (E.C.R.), if available. If the case is not in this reporter, then cite to the official E.U. website with a direct Internet citation (see *BB* 18.2.2 above). If the case is available on the E.U. website, there is no need to cite to an electronic database or a private service.
Part II: Points of Style and Grammar

Internal References to the Piece
The largest subdivisions of pieces, designated by Roman numerals, are referred to as “Parts”; smaller subdivisions designated by capital letters are called “Sections”; and further subdivisions are referred to as “Subsections.” For example:

I. Part
   A. Section
      1. Subsection
         a. Subsection
         b. Subsection
      2. Subsection
   B. Section
II. Part

In addition to use in the text, and contrary to Bluebook Rule 3.5, VLR uses these terms for internal cross-references, rather than calling everything a Part.

Ex. ¹ See infra Section II.A.

Internal references do NOT have periods at the end, unless they are at the end of a sentence.

Ex. Section I.B will provide an overwrought description of the Hand Formula’s philosophical background, from which the analysis in Parts II–IV will benefit in no particularly obvious way.

BUT: Those already familiar with the work of Rich Homie Quan should feel free to skim Subsection II.B.2.

Internal references should be capitalized both above and below the line, but external references should not.

Ex. The third Part of this Note will discuss the rise of the elite group referred to most commonly as the “Sexy XEs.”

Grammar, Punctuation, and Word Choice
This Section provides a quick reference list for some recurrent grammar and style issues.

If you want an answer to a question not addressed by this list or the Bluebook, flag it for the XEs and they will make an ultimate decision. The Chicago Manual of Style, Strunk & White’s The Elements of Style, and Fowler’s A Dictionary of Modern English Usage can also be helpful. All of these guides can be found in the Executive Editors’ office or using Virgo.

(a) Grammar
   (i) Complex nouns
       Usage is generally situational; above all, keep the piece internally consistent.

   (ii) Contractions
       Contractions are almost always inappropriate in our publication. Ed-Board members should change all contractions at the initial edit and cite check stage, for author review.

   (iii) First person
Student note authors are strongly discouraged from using the first person. Other authors may use it as they see fit.

(iv) “However” and “But”
“However” should almost never appear at the beginning or end of a sentence; it should generally appear after the word or phrase that provides the basis for contrast. Use “but” to begin sentences sparingly.

(v) Hyphens and Prefixes
We tend to use hyphens with prefixes, especially where the absence of a hyphen would lead to confusion (for example, “re-call” vs. “recall”) or awkwardness (for example, “anti-male” vs. “antimale”).

(vi) Hyphens and compound modifiers
A compound modifier is a phrase that functions as a unit to modify a noun (for example, state-court decision). In terms of hyphenating compound modifiers, see the Chicago Manual of Style ¶¶ 7.77–7.85 (16th ed. 2010) (Paragraph 7.85 contains a helpful table that provides more extensive guidance on hyphenation). A few examples include:

<table>
<thead>
<tr>
<th>Ex.</th>
<th>BUT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>small-state senators</td>
<td>venture capital fund</td>
</tr>
<tr>
<td>middle-class neighborhood</td>
<td></td>
</tr>
<tr>
<td>fire-brewed beer</td>
<td>this beer is fire brewed</td>
</tr>
<tr>
<td>highly qualified editor</td>
<td></td>
</tr>
</tbody>
</table>

When “century” is used as part of an adjectival phrase (“Jim Manning is a twenty-first-century renaissance man.”), the phrase is hyphenated. When used as a noun (“Joy Guo’s favorite competitive pogo stick team was nearly swept in the World Championship in the early twenty-first century.”), it is not.

Late vs. Mid:
Late twentieth-century developments
Developments of the late twentieth century

Mid-twentieth-century developments
Developments of the mid-twentieth century

When writing ages, hyphenate “year-old” (“Despite her protests about how old she is, Lauren O’Leary still has the energy of a six-year-old child.”).

When “decision-making” is used as part of an adjectival phrase (“Adam Sorensen and Maria Monaghan’s decision-making strategy involves labeling pieces of bologna with Article titles, throwing them at a wall, and seeing what sticks.”), the phrase is hyphenated. When used as a noun (“Emily Reeder used a team of red pandas to grade journal tryouts this year in the hopes they would be better at decision making than the previous year’s team.”), it is not. If you have any questions about hyphenation, flag them for the XEs.
(vii) **Hyphens and dashes:**

Use *hyphens* for compound words and adjectives as noted above (for example, “Adam Stempel, seen here in his trademark drinking-on-a-yacht outfit, was also in attendance.”). Use a regular hyphen for section numbers or other hyphenated numbers that do not indicate a range (for example, M.G.L. § 38-10).

Use the *en-dash*, a slightly longer version of the hyphen, to indicate continuing or inclusive numbers, dates, time, or reference numbers (for example, 1968–72; id. at 38–42). See the Formatting Tips at the end of the *Slatebook* for tips on how to make an en-dash.

Use the *em-dash*, a significantly longer version of the hyphen to set off amplifying, explaining, and digressive elements (for example, “Alex Gorin—whose name happens to be an anagram for axle groin—keeps trying to patent his paella recipe.”). See the Formatting Tips at the end of the *Slatebook* for tips on how to make an em-dash.

(viii) **Split Infinitives**

A split infinitive is a construction consisting of an infinitive with an adverb or other word inserted between *to* and the verb (for example, “To boldly go where no one has gone before”). Split infinitives are *usually inappropriate* for academic writing. Use them sparingly, where a sentence needs extra stress on the adverb. The most important rule for split infinitives is to follow your ear. As *The Elements of Style* says, “Some infinitives seem to improve on being split.”

(ix) **Articles Before Initialisms and Acronyms**

An initialism is an abbreviation read as a series of letters (“FBI”), and an acronym is an abbreviation pronounced as a word (“NASA”). When an abbreviation is used as an adjective, an article must be used and should be appropriate to the noun the abbreviation modifies.

Ex. The IRS auditor found evidence of tax evasion.
   The NSF expedition unearthed remains of Mitochondrial Eve.
   An IBM computer beat Kasparov.

When an initialism is used as a noun, a definite article must be used, but acronyms used as nouns should not have articles.

Ex. The FBI issued a statement.
   The Editorial Board of the VLR.
   NASA launched another rocket.
   Members of PILA.
   BUT:
   Students at UVA.

Indefinite articles should match the pronunciation of the abbreviation.

Ex. A NATO member country
   An NIH advisory

(b) **Punctuation**

(i) **Colons, Commas, and Quotations**
Use only one space after a colon. A footnote call should precede a colon (Rule 1.1(a), BB p. 57). Capitalize the first letter of the word after the colon if the word following the colon is part of a title, a proper noun, or the material introduced by the colon is a full sentence.

Ex. After the heart attack his family said he died doing what he loved: editing law review articles.
BUT: If there’s one guiding principle at VLR it’s this: There are snacks in Ollie’s office.

When a comma or colon introduces a quotation, the first letter of the word after the comma or colon should usually be capitalized. One exception is when the quotation is merely a phrase and the comma is part of the overall sentence. See the examples below.

Ex. The professor left the class with the following question: “How much wood would a woodchuck chuck if a woodchuck could chuck wood?”

Ex. Dorothy said, “We are not in Kansas anymore.”
The Court stated, “Separate but equal is inherently unequal.”
Ben Kuder, a renowned alligator wrestler, “has never lost a fight.”

(ii) Decades
“1980s,” not “1980’s.”

(iii) Lists and Series
The preferred comma usage is “X, Y, and Z,” not “X, Y and Z.” The same rule is used for other conjunctions.

(iv) Parentheses
Leave a space between right and left parentheses.


(v) Quotation Marks
Commas and periods go inside quotation marks; colons, semicolons, question marks, and exclamation marks go outside unless they are part of the quoted passage.

(vi) Apostrophes
The possessive of singular nouns is formed by the addition of an apostrophe and an s, and the possessive of plural nouns (except for a few irregular plurals) by the addition of only an apostrophe.

Ex. The editors’ bane
Congress’s will, NOT Congress’ will
James’s desk, NOT James’ desk

Exception: The United States, although singular in construction, should receive only an apostrophe.

Ex. The United States’ passion for Taylor Swift is unmatched.
NOT: I wonder if Taylor Swift affects the United States’s world reputation?

If two or more entities possess something jointly, the latter noun takes the possessive ending.
If two nouns each possess something separately, they each receive a possessive ending.
Ex. Adam and Maria’s office
Adam’s and Maria’s cell phones

(vii) Footnote Calls
Place after commas, semicolons periods, and quotation marks, but before dashes, colons, and ellipses. Place outside parentheses unless only referring to material within the parenthetical.

(viii) Numbered Lists
If an author includes a numbered list in a textual sentence, the numbers should be in Arabic numerals (that is, not Roman numerals) and enclosed in parentheses.

Ex. In order to remove a student from the VLR, the Editor-in-Chief must prove (1) that he did not check every word in the quotations in his cite check; (2) that he considered attending Duke Law School; or (3) that he brought alcohol into the VLR offices without bringing enough for everyone else.

(c) Word Choice
(i) “Legitimate” or “legitimize”
Usually the first is an adjective and the second a verb.

(ii) “Alternate” or “alternative”
The first is used in the sense of “every other” or “replacement,” the second in the sense of other available paths. (The more common error is to use “alternate” where “alternative” is needed.)

(iii) “Which” or “that”
Use “which” to introduce nonrestrictive clauses, which generally follow a comma. For restrictive (that is, no-comma) clauses, use “that.”

Ex. The Virginia Law Review, which is published eight times a year, is the only legal periodical that publishes a swimsuit issue.
The only journal that publishes a swimsuit issue is the Virginia Law Review.

Good writers, however, often violate this rule of thumb for reasons of style or balance.

Ex. Never use a metaphor, simile or other figure of speech which you are used to seeing in print. George Orwell, Politics and the English Language.

(iv) “Whether”
Delete the words “or not” from the phrase “whether or not” where possible. (Retain “or not” when the phrase is used to mean “regardless of whether.”)

(v) “I.e.” or “that is” and “e.g.” or “for example”
In textual sentences, whether in the text or in a footnote, we prefer the second, English form. There are enough unintelligible Latin phrases in legal writing that we can improve a piece aesthetically with this simple rule.

(vi) “Impact”
Writers often use the word “impact” as a verb to mean “to have an effect on” or “to influence.” In such cases, VLR prefers the verb “affect.”
(vii) “Irregardless” should never be used.

(viii) “Due to” means “attributable to,” not “because of.”

Ex. The VLR Feb Club party had to be canceled because of inadequate funds.
NOT: The VLR Feb Club party had to be canceled due to inadequate funds.

Ex.: VLR’s hemorrhaging deficit was due to the extravagant meals consumed by the XEs during their so-called “page-proofing” sessions.

(ix) The Subjunctive Mood

Must be maintained at all reasonable costs in all fact-conditional sentences. Key words that nearly always signal the subjunctive mood include: if, as if, although, as though, unless, and (more occasionally) whether.

Ex. If I were a rich man, I would not have to work hard.
NOT: If I was a rich man, I would not have to work hard.

Ex. I would not state that the Patriots are the greatest football team of all time unless it were true.
NOT: I would not state that the Patriots are the greatest football team of all time unless it was true.

(x) “Myriad”

This word literally and directly means “ten thousand.” As such, it can never be bracketed with the words “a” and “of.” Just as you cannot say “a ten thousand of,” you cannot say “a myriad of.” “Myriad” stands alone in its sentence.

Wrong: There are a myriad of reasons why this construction is wrong.
(Think: “There are a ten thousand of reasons why this construction is wrong.”)

Right: There are myriad reasons why this construction is right. (Think: “There are ten thousand reasons why this construction is right.”)

(xi) “Outside”

“Of” comes after “outside” only when “outside” is a noun.

Ex. I painted the outside of the house.
There are no legitimate baseball teams outside Boston.

(xii) “Only”

“Only” should immediately precede the word it modifies. See Chicago Manual of Style ¶5.182. The late David Foster Wallace, a paragon of grammatical snootiness, taught it thus:

While your neighbor was on vacation, he asked that you care for his dog. Upon returning, your friend informs you, he found his dog languid and depressed. The following dialogue ensues:

“I fed the dog.”
“Did you feed the parakeet?”
“I fed only the dog.”
“Did anyone else feed the dog?”
“Only I fed the dog.”
“Well what did you feed the dog?”
“I fed the dog only dog food.”
“Did you molest the dog?”
“I only fed the dog.”

(xiii) “Each other” vs. “One another”
“Each other” is used when there are exactly two parties in reference; “one another” is used when referring to more than two parties.

(xiv) “Common law” and “State law” used as adjectives
These phrases should not have hyphens when they are used. This is an exception to the Chicago Manual of Style hyphen rules.

Ex. The common law tradition has endured for many state law causes of action.
NOT: The common-law method is anachronistic.
Part III: Formatting Tips

Nonbreaking Spaces: Ellipses
The spaces *within* any ellipsis (whether three or four periods in length) should be nonbreaking spaces. (DEs should note that nonbreaking spaces can be typed in Microsoft Word by pressing ctrl-shift and the space bar at the same time.) Similarly, the space between the word *preceding* an ellipsis and the ellipsis itself should be a nonbreaking space. That is, *the ellipsis is attached to the word that comes before it.* The space after the ellipsis should be a regular space, *unless* the ellipsis does not end a sentence but merely connects words within the same sentence; in that case, the space after the ellipsis should also be a nonbreaking space. This allows text lines to break after an ellipsis, while preventing an ellipsis (or worse, part of an ellipsis) from starting a new line of text.

Symbols
A nonbreaking space must be used between a § or ¶ and the numbers that follow, as well as between “F.” and “Supp.,” to prevent a line break from separating the two. Nonbreaking spaces can be typed in Word by pressing ctrl-shift and the space bar together, or by going to Insert → Symbol → Special Characters and selecting the appropriate symbol.

En-dashes
As noted above, the en-dash is used for continuing or inclusive numbers, dates, times, or reference numbers. On some computers, an en-dash can be formed in MS Word by pressing Ctrl at the same time as the hyphen key on the number keypad. Another way to create an en-dash is to type a word (or number), insert a space, type one hyphen, insert a space, type another word (or number), and then insert another space. Then go back and close up the spaces between the en-dash and the words (or numbers). If all else fails, go to Insert → Symbol → Special Characters and select the en-dash.

Em-dashes
As also noted above, the em-dash is used to set off amplifying, explaining, and digressing elements. On some computers, an em-dash can be formed in MS Word by pressing Ctrl+Alt at the same time as the hyphen key on the number keypad. Another easy way to form an em-dash is to type a word, type two hyphens (with no spaces), type another word, then type the space bar. If all else fails, go to Insert → Symbol → Special Characters and select the em-dash.

Cross-References
When using supra or infra to refer to another footnote or footnotes in the piece, it is imperative that you insert a cross-reference rather than just type in the number. This means replacing all existing jump cites with cross-references. This will save time in the long run because the cite will then automatically update when new footnotes are added or others deleted. To insert a cross-reference, go to Insert → Cross-reference → Footnote and click on the appropriate footnote. Note that supra and infra should only be used as part of a citation or internal cross reference, not in textual material.

For periodical abbreviations in languages other than English, see rules 20.2.3 and 20.6.

For online supplements to the print publication, use the citation for the print publication, followed by the online supplement name.

**COLUM. L. REV. SIDEBAR**

<table>
<thead>
<tr>
<th>A-B</th>
<th>A-B</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Journal</td>
<td>A.B.A. J.</td>
</tr>
<tr>
<td>Academic</td>
<td>ACAD.</td>
</tr>
<tr>
<td>Account</td>
<td>ACCT.</td>
</tr>
<tr>
<td>Adelaide Law Review</td>
<td>ADEL. Rev.</td>
</tr>
<tr>
<td>Administrative Law Review</td>
<td>ADMIN. L. Rev.</td>
</tr>
<tr>
<td>Advocates</td>
<td>ADVOC.</td>
</tr>
<tr>
<td>Affairs</td>
<td>AFF.</td>
</tr>
<tr>
<td>Africa</td>
<td>AFR.</td>
</tr>
<tr>
<td>Agriculture</td>
<td>AGRIC.</td>
</tr>
<tr>
<td>Air</td>
<td>Air</td>
</tr>
<tr>
<td>Akron Tax Journal</td>
<td>AKRON TAX J.</td>
</tr>
<tr>
<td>Albany Law Journal of Science &amp; Technology</td>
<td>ALB. L.J. SCI. &amp; TECH.</td>
</tr>
<tr>
<td>America</td>
<td>AM.</td>
</tr>
<tr>
<td>American Bankruptcy Institute Law Review</td>
<td>AM. BANKR. INST. L. REV.</td>
</tr>
<tr>
<td>American Bankruptcy Law Journal</td>
<td>AM. BANKR. L.J.</td>
</tr>
<tr>
<td>American Bar Association</td>
<td>A.B.A.</td>
</tr>
<tr>
<td>American Bar Foundation Research Journal</td>
<td>AM. B. FOUND. RES. J.</td>
</tr>
<tr>
<td>American Business Law Journal</td>
<td>AM. BUS. L.J.</td>
</tr>
<tr>
<td>American Criminal Law Review</td>
<td>AM. CRIM. L. Rev.</td>
</tr>
<tr>
<td>American Journal of Comparative Law</td>
<td>AM. J. COMP. L.</td>
</tr>
<tr>
<td>American Journal of Criminal Law</td>
<td>AM. J. CRIM. L.</td>
</tr>
<tr>
<td>American Journal of International Law</td>
<td>AM. J. INT’L L.</td>
</tr>
<tr>
<td>American Journal of Jurisprudence</td>
<td>AM. J. JURIS.</td>
</tr>
<tr>
<td>American Journal of Law &amp; Medicine</td>
<td>AM. J. L. &amp; MED.</td>
</tr>
<tr>
<td>American Journal of Legal History</td>
<td>AM. J. LEGAL HIST.</td>
</tr>
<tr>
<td>Periodicals</td>
<td>Abbreviations</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>American Journal of Trial Advocacy</td>
<td>AM. J. TRIAL ADVOC.</td>
</tr>
<tr>
<td>American Law Institute</td>
<td>A.L.I.</td>
</tr>
<tr>
<td>American Law Reports</td>
<td>A.L.R.</td>
</tr>
<tr>
<td>American Review of International Arbitration</td>
<td>AM. REV. INT'L ARB.</td>
</tr>
<tr>
<td>American University International Law Review</td>
<td>AM. U. INT'L L. REV.</td>
</tr>
<tr>
<td>American University Journal of Gender, Social Policy &amp; the Law</td>
<td>AM. U. J. GENDER SOC. POLY' &amp; L.</td>
</tr>
<tr>
<td>American University Law Review</td>
<td>AM. U. L. REV.</td>
</tr>
<tr>
<td>and</td>
<td>ANGLO-AM. L. REV.</td>
</tr>
<tr>
<td>Anglo-American Law Review</td>
<td>ANIMAL L.</td>
</tr>
<tr>
<td>Animal Law</td>
<td>ANNALS</td>
</tr>
<tr>
<td>Annals</td>
<td>ANNALS AM. ACAD. POL. &amp; SOC. SCI.</td>
</tr>
<tr>
<td>Annals of the American Academy of Political and Social Science</td>
<td>ANNALS HEALTH L.</td>
</tr>
<tr>
<td>Annals of Health Law</td>
<td>ANN.</td>
</tr>
<tr>
<td>Annual</td>
<td>ANN. REV. BANKING &amp; FIN. L.</td>
</tr>
<tr>
<td>Annual Review of Banking &amp; Financial Law</td>
<td>ANN. REV. BANKING L.</td>
</tr>
<tr>
<td>Annual Review of Banking Law</td>
<td>ANN. SURV. AM. L.</td>
</tr>
<tr>
<td>Annual Survey of American Law</td>
<td>ANN. SURV. INT'L &amp; COMP. L.</td>
</tr>
<tr>
<td>Annual Survey of International and Comparative Law</td>
<td>ANTITRUST</td>
</tr>
<tr>
<td>Antitrust</td>
<td>APP.</td>
</tr>
<tr>
<td>Appellate</td>
<td>ARB.</td>
</tr>
<tr>
<td>Arbitrator</td>
<td>ARIZ. J. INT'L &amp; COMP. L.</td>
</tr>
<tr>
<td>Arizona Journal of International and Comparative Law</td>
<td>ARIZ. L. REV.</td>
</tr>
<tr>
<td>Arizona Law Review</td>
<td>ARIZ. ST. L.J.</td>
</tr>
<tr>
<td>Arizona State Law Journal</td>
<td>ARK. L. NOTES</td>
</tr>
<tr>
<td>Arkansas Law Notes</td>
<td>ARK. L. REV.</td>
</tr>
<tr>
<td>Arkansas Law Review</td>
<td>ARMY LAW.</td>
</tr>
<tr>
<td>Army Lawyer</td>
<td>ART</td>
</tr>
<tr>
<td>Asian American Law Journal</td>
<td>ASIAN AM. L.J.</td>
</tr>
<tr>
<td>Asian Pacific American Law Journal</td>
<td>ASIAN PAC. AM. L.J.</td>
</tr>
<tr>
<td>Asian-Pacific Law &amp; Policy Journal</td>
<td>ASIAN-PAC. L. &amp; POL'Y J.</td>
</tr>
<tr>
<td>Association</td>
<td>ASS'N</td>
</tr>
<tr>
<td>Attorney</td>
<td>ATT'Y</td>
</tr>
<tr>
<td>Auckland University Law Review</td>
<td>AUCKLAND U. L. REV.</td>
</tr>
<tr>
<td>Ave Maria Law Review</td>
<td>AVE MARIA L. REV.</td>
</tr>
<tr>
<td>Bankruptcy</td>
<td>BANKR.</td>
</tr>
<tr>
<td>Bankruptcy Developments Journal</td>
<td>BANKR. DEV. J.</td>
</tr>
<tr>
<td>Bar</td>
<td>B.</td>
</tr>
<tr>
<td>Baylor Law Review</td>
<td>BAYLOR L. REV.</td>
</tr>
<tr>
<td>Behavioral[al]</td>
<td>BEHAV.</td>
</tr>
<tr>
<td>Behavioral Sciences and the Law</td>
<td>BEHAV. SCI. &amp; L.</td>
</tr>
<tr>
<td>Berkeley Journal of International Law</td>
<td>BERKELEY J. INT'L L.</td>
</tr>
</tbody>
</table>
Berkeley Technology Law Journal
Berkeley Women's Law Journal
Boston College Environmental Affairs Law Review
Boston College International and Comparative Law Review
Boston College Law Review
Boston University International Law Journal
Boston University Journal of Science & Technology Law
Boston University Law Review
Boston University Public Interest Law Journal
Brandeis Law Journal
Briefcase
Brigham Young University Education and Law Journal
Brigham Young University Journal of Public Law
Brigham Young University Law Review
British
Brooklyn Journal of International Law
Brooklyn Law Review
Buffalo Criminal Law Review
Buffalo Environmental Law Journal
Buffalo Human Rights Law Review
Buffalo Law Review
Buffalo Public Interest Law Journal
Buffalo Women's Law Journal
Bulletin
Business
Business Law Journal
Business Lawyer
Business Week

C-D
California Bankruptcy Journal
California Criminal Law Review
California Law Review
California Regulatory Law Reporter
California State Bar Journal
California Western International Law Journal
California Western Law Review
Cambridge Law Journal
Campbell Law Review
Canada-United States Law Journal
Capital Defense Digest
Capital Defense Journal
<table>
<thead>
<tr>
<th>Periodicals</th>
<th>Abbreviations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital University Law Review</td>
<td>CAP. U. L. REV.</td>
</tr>
<tr>
<td>Cardozo Arts &amp; Entertainment Law Journal</td>
<td>CARDozo ARTS &amp; ENT. L.J.</td>
</tr>
<tr>
<td>Cardozo Journal of Conflict Resolution</td>
<td>CARDozo J. CONFLICT RESOL.</td>
</tr>
<tr>
<td>Cardozo Journal of International and Comparative Law</td>
<td>CARDozo J. INT’L &amp; COMP. L.</td>
</tr>
<tr>
<td>Cardozo Law Review</td>
<td>CARDozo L. REV.</td>
</tr>
<tr>
<td>Cardozo Online Journal of Conflict Resolution</td>
<td>CARDozo ONLINE J. CONFLICT RESOL.</td>
</tr>
<tr>
<td>Cardozo Women’s Law Journal</td>
<td>CARDozo WOMEN’S L.J.</td>
</tr>
<tr>
<td>Case &amp; Comment</td>
<td>CASE &amp; COMMENT</td>
</tr>
<tr>
<td>Case Western Reserve Journal of International Law</td>
<td>CASE W. RES. J. INT’L L.</td>
</tr>
<tr>
<td>Case Western Reserve Law Review</td>
<td>CASE W. RES. L. REV.</td>
</tr>
<tr>
<td>Catholic Lawyer</td>
<td>CATH. LAW.</td>
</tr>
<tr>
<td>Catholic University Law Review</td>
<td>CATH. U. L. REV.</td>
</tr>
<tr>
<td>Central</td>
<td>CENT.</td>
</tr>
<tr>
<td>Chapman Law Review</td>
<td>CHAP. L. REV.</td>
</tr>
<tr>
<td>Chartered Life Underwriters</td>
<td>C.L.U.</td>
</tr>
<tr>
<td>Chicago Tribune</td>
<td>CHI. TRIB.</td>
</tr>
<tr>
<td>Chicago Journal of International Law</td>
<td>CHI. J. INT’L L.</td>
</tr>
<tr>
<td>Chicago-Kent Law Review</td>
<td>CHI.-KENT L. REV.</td>
</tr>
<tr>
<td>Chicano-Latino Law Review</td>
<td>CHICANO-LATINO L. REV.</td>
</tr>
<tr>
<td>Child[ren, ren’s]</td>
<td>CHILD.</td>
</tr>
<tr>
<td>Children’s Legal Rights Journal</td>
<td>CHILD. LEGAL RTS. J.</td>
</tr>
<tr>
<td>Chronicle</td>
<td>CHRON.</td>
</tr>
<tr>
<td>Civil</td>
<td>CIV.</td>
</tr>
<tr>
<td>Civil Libert[y, ies]</td>
<td>C.L.</td>
</tr>
<tr>
<td>Civil Rights</td>
<td>C.R.</td>
</tr>
<tr>
<td>Clearinghouse Review</td>
<td>CLEARINGHOUSE REV.</td>
</tr>
<tr>
<td>Cleveland State Law Review</td>
<td>CLEV. ST. L. REV.</td>
</tr>
<tr>
<td>Clinical Law Review</td>
<td>CLINICAL L. REV.</td>
</tr>
<tr>
<td>College</td>
<td>C.</td>
</tr>
<tr>
<td>Colorado Lawyer</td>
<td>COLO. LAW.</td>
</tr>
<tr>
<td>Columbia Business Law Review</td>
<td>COLUM. BUS. L. REV.</td>
</tr>
<tr>
<td>Columbia Human Rights Law Review</td>
<td>COLUM. HUM. RTS. L. REV.</td>
</tr>
<tr>
<td>Columbia Journal of Asian Law</td>
<td>COLUM. J. ASIAN L.</td>
</tr>
<tr>
<td>Columbia Journal of East European Law</td>
<td>COLUM. J. E. EUR. L.</td>
</tr>
<tr>
<td>Columbia Journal of Environmental Law</td>
<td>COLUM. J. ENVTL. L.</td>
</tr>
<tr>
<td>Columbia Journal of European Law</td>
<td>COLUM. J. EUR. L.</td>
</tr>
<tr>
<td>Columbia Journal of Gender and Law</td>
<td>COLUM. J. GENDER &amp; L.</td>
</tr>
<tr>
<td>Columbia Journal of Law and Social Problems</td>
<td>COLUM. J.L. &amp; SOC. PROBS.</td>
</tr>
<tr>
<td>Columbia Journal of Law &amp; the Arts</td>
<td>COLUM. J.L. &amp; ARTS</td>
</tr>
<tr>
<td>Columbia Journal of Transnational Law</td>
<td>COLUM. J. TRANSNAT’L L.</td>
</tr>
<tr>
<td>Columbia Law Review</td>
<td>COLUM. L. REV.</td>
</tr>
</tbody>
</table>
Columbia Science and Technology Law Review
Columbia-VLA Journal of Law & the Arts
Commentary
Commercial Law
Commercial Law Conspicuous: Journal of Communications Law & Policy
Common Market Law Review
Communication[s]
Comparative
Comparative Labor Law Journal
Comparative Labor Law & Policy Journal
Computer
Computer/Law Journal
Computer Law Review & Technology Journal
Conference
Congressional
Congressional Digest
Connecticut Insurance Law Journal
Connecticut Journal of International Law
Connecticut Law Review
Connecticut Probate Law Journal
Constitution[s]
Constitutional Commentary
Consumer
Consumer Finance Law Quarterly Report
Contemporary
Contract[s]
Conveyancer and Property Lawyer (new series)
Copyright Law Symposium (American Society of Composers, Authors, & Publishers)
Cornell International Law Journal
Cornell Journal of Law and Public Policy
Cornell Law Review
Corporate[e, ion]
Corporate Taxation
Counsel[or, ors, or's]
Court
Creighton Law Review
Crime
Criminal
Criminal Law Forum
Criminal Law Review
Criminal Law Bulletin
Criminology
Cumberland Law Review
Current Medicine for Attorneys
COLUM. SCI. & TECH. L. REV.
COLUM.-VLA J.L. & ARTS
COMMENT.
COM.
COMMLAW CONSPICUS
COMMON MKT. L. REV.
COMM.
COMP.
COMP. LAB. L.J.
COMP. LAB. L. & POL'Y J.
COMPUTER
COMPUTER/L.J.
COMPUTER L. REV. & TECH J.
CONF.
CONG.
CONG. DIG.
CONN. INS. L.J.
CONN. J. INT'L L.
CONN. L. REV.
CONN. PROB. L.J.
CONST.
CONST. COMMENT.
CONSUMER
CONSUMER FIN. L. Q. REP.
CONTEMP.
CONT.
CONV. & PROP. LAW. (n.s.)
COPYRIGHT L. SYMP.
(ASCAP)
CORNELL INT'L L.J.
CORNELL J.L. & PUB. POL'Y
CORNELL L. REV.
CORP.
CORP. TAX'N
COUNS.
CT.
CREIGHTON L. REV.
CRIME
CRIM.
CRIM. L.F.
CRIM. L. REV.
CRIM. L. BULL.
CRIMINOLOGY
CUMB. L. REV.
CURRENT MED. FOR ATT'YS
Periodicals

- Currents: The International Trade Law Journal
- Dalhousie Law Journal
- DePaul Business Law Journal
- DePaul Business & Commercial Law Journal
- DePaul Journal of Health Care Law
- DePaul Law Review
- DePaul-LCA Journal of Art and Entertainment Law and Policy
- Defense
- Defense Counsel Journal
- Delaware Journal of Corporate Law
- Delaware Law Review
- Delinquency
- Denver Journal of International Law and Policy
- Denver University Law Review
- Department of State Bulletin
- Development[s]
- Dickinson International Law Annual
- Dickinson Law Review
- Digest
- The Digest: The National Italian-American Bar Ass'n Law Journal
- Diplomacy
- Dispute
- District of Columbia Law Review
- Drake Journal of Agricultural Law
- Drake Law Review
- Duke Environmental Law & Policy Forum
- Duke Journal of Comparative & International Law
- Duke Journal of Gender Law & Policy
- Duke Law Journal
- Duquesne Business Law Journal
- Duquesne Law Review
- Employee Rights and Employment Policy Journal
- Econom[ic, ics, y]
- The Economist
- Education[al]
- Elder Law Journal
- Emory Bankruptcy Developments Journal
- Emory International Law Review
- Emory Law Journal
- Employ[ee, ment]
<table>
<thead>
<tr>
<th>Periodicals</th>
<th>Abbreviations</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Forum</td>
<td>Forum</td>
</tr>
<tr>
<td>Foundation[s]</td>
<td>Found.</td>
</tr>
<tr>
<td>Franchise Law Journal</td>
<td>Franchise L.J.</td>
</tr>
<tr>
<td>G-H</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td>Gender</td>
</tr>
<tr>
<td>General</td>
<td>GEN.</td>
</tr>
<tr>
<td>George Mason Law Review</td>
<td>GEO. MASON L. REV.</td>
</tr>
<tr>
<td>George Mason University Civil Rights Law Journal</td>
<td>GEO. MASON U. C.R. L.J.</td>
</tr>
<tr>
<td>George Washington International Law Review</td>
<td>GEO. WASH. INT'L L. REV.</td>
</tr>
<tr>
<td>George Washington Law Review</td>
<td>GEO. WASH. L. REV.</td>
</tr>
<tr>
<td>Georgetown Immigration Law Journal</td>
<td>GEO. IMMIGR. L.J.</td>
</tr>
<tr>
<td>Georgetown International Environmental Law Review</td>
<td>GEO. INT'L ENVTL. L. REV.</td>
</tr>
<tr>
<td>The Georgetown Journal of Gender and the Law</td>
<td>GEO. J. GENDER &amp; L.</td>
</tr>
<tr>
<td>Georgetown Journal of International Law</td>
<td>GEO. J. INT'L L.</td>
</tr>
<tr>
<td>Georgetown Journal of Legal Ethics</td>
<td>GEO. J. LEGAL ETHICS</td>
</tr>
<tr>
<td>Georgetown Journal on Poverty Law and Policy</td>
<td>GEO. J. ON POVERTY L. &amp; POL'Y</td>
</tr>
<tr>
<td>Georgetown Law Journal</td>
<td>GEO. L.J.</td>
</tr>
<tr>
<td>Georgia Journal of International and Comparative Law</td>
<td>GA. J. INT'L &amp; COMP. L.</td>
</tr>
<tr>
<td>Georgia Law Review</td>
<td>GA. L. REV.</td>
</tr>
<tr>
<td>Georgia State University Law Review</td>
<td>GA. ST. U. L. REV.</td>
</tr>
<tr>
<td>Glendale Law Review</td>
<td>GLENDALE L. REV.</td>
</tr>
<tr>
<td>Golden Gate University Law Review</td>
<td>GOLDEN GATE U. L. REV.</td>
</tr>
<tr>
<td>Gonzaga Law Review</td>
<td>GONZ. L. REV.</td>
</tr>
<tr>
<td>Government</td>
<td>GOV'T</td>
</tr>
<tr>
<td>Great Plains Natural Resources Journal</td>
<td>GREAT PLAINS NAT. RESOURCES J.</td>
</tr>
<tr>
<td>Green Bag</td>
<td>GREEN BAG</td>
</tr>
<tr>
<td>Guild Practitioner</td>
<td>GUILD PRAC.</td>
</tr>
<tr>
<td>Hamline Journal of Public Law and Policy</td>
<td>HAMLINE J. PUB. L. &amp; POL'Y</td>
</tr>
<tr>
<td>Hamline Law Review</td>
<td>HAMLINE L. REV.</td>
</tr>
<tr>
<td>Harvard Civil Rights-Civil Liberties Law Review</td>
<td>HARV. C.R.-C.L. L. REV.</td>
</tr>
<tr>
<td>Harvard Environmental Law Review</td>
<td>HARV. ENVTL. L. REV.</td>
</tr>
<tr>
<td>Harvard Human Rights Journal</td>
<td>HARV. HUM. RTS. J.</td>
</tr>
<tr>
<td>Harvard International Law Journal</td>
<td>HARV. INT'L L.J.</td>
</tr>
<tr>
<td>Harvard Journal of Law and Gender</td>
<td>HARV. J.L. &amp; GENDER</td>
</tr>
<tr>
<td>Harvard Journal of Law &amp; Technology</td>
<td>HARV. J.L. &amp; TECH.</td>
</tr>
<tr>
<td>Harvard Journal on Legislation</td>
<td>HARV. J. ON LEGIS.</td>
</tr>
<tr>
<td>Harvard Journal on Racial &amp; Ethnic Justice</td>
<td>HARV. J. ON RACIAL &amp; ETHNIC JUST.</td>
</tr>
<tr>
<td>Harvard Latino Law Review</td>
<td>HARV. LATINO L. REV.</td>
</tr>
<tr>
<td>Periodicals</td>
<td>Title</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>Harvard Law Review</td>
<td>HARV. L. REV.</td>
</tr>
<tr>
<td>Harvard Negotiation Law Review</td>
<td>HARV. NEGOT. L. REV.</td>
</tr>
<tr>
<td>Harvard Women’s Law Journal</td>
<td>HARV. WOMEN’S L.J.</td>
</tr>
<tr>
<td>Hastings Communications and Entertainment Law Journal</td>
<td>HASTINGS COMM. &amp; ENT. L.J.</td>
</tr>
<tr>
<td>Hastings Constitutional Law Quarterly</td>
<td>HASTINGS CONST. L.Q.</td>
</tr>
<tr>
<td>Hastings International and Comparative Law Review</td>
<td>HASTINGS INT’L &amp; COMP. L. REV.</td>
</tr>
<tr>
<td>Hastings Law Journal</td>
<td>HASTINGS L.J.</td>
</tr>
<tr>
<td>Hastings Women’s Law Journal</td>
<td>HASTINGS WOMEN’S L.J.</td>
</tr>
<tr>
<td>Health</td>
<td>HEALTH</td>
</tr>
<tr>
<td>Health Matrix</td>
<td>HEALTH MATRIX</td>
</tr>
<tr>
<td>Herald</td>
<td>HERALD</td>
</tr>
<tr>
<td>High Technology Law Journal</td>
<td>HIGH TECH. L.J.</td>
</tr>
<tr>
<td>Hispanic</td>
<td>HISP.</td>
</tr>
<tr>
<td>Histor[ical, y]</td>
<td>HIST.</td>
</tr>
<tr>
<td>Hofstra Labor &amp; Employment Law Journal</td>
<td>HOFSTRA LAB. &amp; EMP. L.J.</td>
</tr>
<tr>
<td>Hofstra Law Review</td>
<td>HOFSTRA L. REV.</td>
</tr>
<tr>
<td>Hospital</td>
<td>HOSP.</td>
</tr>
<tr>
<td>Houston Journal of International Law</td>
<td>HOUS. J. INT’L L.</td>
</tr>
<tr>
<td>Houston Law Review</td>
<td>HOUS. L. REV.</td>
</tr>
<tr>
<td>Howard Law Journal</td>
<td>HOW. L.J.</td>
</tr>
<tr>
<td>Human</td>
<td>HUM.</td>
</tr>
<tr>
<td>Human Rights Quarterly</td>
<td>HUM. RTS. Q.</td>
</tr>
<tr>
<td>Humanit[ies]</td>
<td>HUMAN.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I-J</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idaho Law Review</td>
</tr>
<tr>
<td>IDEA: The Intellectual Property Law Review</td>
</tr>
<tr>
<td>Illinois Bar Journal</td>
</tr>
<tr>
<td>ILSA Journal of International &amp; Comparative Law</td>
</tr>
<tr>
<td>Immigration</td>
</tr>
<tr>
<td>Immigration and Nationality Law Review</td>
</tr>
<tr>
<td>In the Public Interest</td>
</tr>
<tr>
<td>Independent</td>
</tr>
<tr>
<td>Indian</td>
</tr>
<tr>
<td>Indiana International &amp; Comparative Law Review</td>
</tr>
<tr>
<td>Indiana Journal of Global Legal Studies</td>
</tr>
<tr>
<td>Indiana Law Journal</td>
</tr>
<tr>
<td>Indiana Law Review</td>
</tr>
<tr>
<td>Industrial</td>
</tr>
<tr>
<td>Industrial and Labor Relations Review</td>
</tr>
<tr>
<td>Information</td>
</tr>
</tbody>
</table>
Periodicals

- Injury
- Institute
- Institute on Federal Taxation
- Institute on Oil and Gas Law and Taxation
- Institute on Planning, Zoning, and Eminent Domain
- Institute on Private Investments and Investors Abroad
- Institute on Securities Regulation
- Insurance
- Intellectual
- Interdisciplinary
- Interest
- International
- International and Comparative Law Quarterly
- International Herald Tribune
- International Journal of Law and Psychiatry
- International Lawyer
- International Organization
- International Organization Law Review
- International Review of Law and Economics
- Iowa Law Review
- JAG Journal
- John Marshall Journal of Computer & Information Law
- John Marshall Law Review
- Journal
- Journal of Agricultural Law
- Journal of Air Law and Commerce
- Journal of Appellate Practice and Process
- Journal of Business Law
- Journal of Chinese Law
- Journal of College and University Law
- Journal of Contemporary Health Law and Policy
- Journal of Contemporary Law
- Journal of Contemporary Legal Issues
- Journal of Corporate Taxation
- Journal of Corporation Law
- Journal of Criminal Law and Criminology
- Journal of Dispute Resolution
- Journal of Energy, Natural Resources & Environmental Law
- Journal of Environmental Law and Litigation
- Journal of Family Law
- Journal of Gender, Race and Justice
**Periodicals**

- Judge
- Judicature
- Judicial
- Juridical Review
- Jurimetrics: The Journal of Law, Science, and Technology
- Juris Doctor
- Juris Magazine
- Jurist
- Justice
- Justice System Journal
- Juvenile
- Journal of Products Liability

**K-L**

- Kansas Journal of Law and Public Policy
- Kentucky Law Journal
- Labor
- Labor Law Journal
- Labor Lawyer
- Land
- La Raza Law Journal
- Law (first word)
- Law
- Law and Contemporary Problems
- Law and History Review
- Law and Human Behavior
- Law and Inequality
- Law and Policy in International Business
- Law & Psychology Review
- Law & Social Inquiry
- Law & Society Review
- Law Library Journal
- Lawyer[s, s', 's]
- Lawyer's Reports Annotated
- Legal
- Legisl[ation, ive]
- Lewis & Clark Law Review
- Librar[y, ian, ies]
- Lincoln Law Review
- Litigation
- Local
- Louisiana Law Review
- Loyola Consumer Law Review
- Loyola Journal of Public Interest Law
- Loyola Law Review (New Orleans)

**KAN. J.L. & PUB. POL’Y**

- KY. L.J.
- LAB.
- LAB. L.J.
- LAB. LAW.
- LAND
- LA RAZA L.J.
- LAW
- L.
- LAW & CONTEMP. PROBS.
- LAW & HIST. REV.
- LAW & HUM. BEHAV.
- LAW & INEQ.
- LAW & POL’Y INT’L BUS.
- LAW & PSYCHOL. REV.
- LAW & SOC. INQUIRY
- LAW & SOC’Y REV.
- LAW LIBR. J.
- LAW.
- L.R.A.
- LEGAL
- LEGIS.
- LEWIS & CLARK L. REV.
- LIBR.
- LINCOLN L. REV.
- LITIG.
- LOC.
- LA. L. REV.
- LOY. CONSUMER L. REV.
- LOY. J. PUB. INT. L.
- LOY. L. REV.
<table>
<thead>
<tr>
<th>Periodicals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loyola of Los Angeles Entertainment Law Review</td>
</tr>
<tr>
<td>Loyola of Los Angeles Law Review</td>
</tr>
<tr>
<td>Loyola University of Chicago Law Journal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M-N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magazine</td>
</tr>
<tr>
<td>Maine Law Review</td>
</tr>
<tr>
<td>Major Tax Planning</td>
</tr>
<tr>
<td>Management</td>
</tr>
<tr>
<td>Maritime</td>
</tr>
<tr>
<td>Marquette Law Review</td>
</tr>
<tr>
<td>Marquette Sports Law Review</td>
</tr>
<tr>
<td>Maryland Journal of Contemporary Legal Issues</td>
</tr>
<tr>
<td>Maryland Journal of International Law and Trade</td>
</tr>
<tr>
<td>Maryland Law Review</td>
</tr>
<tr>
<td>Massachusetts Law Review</td>
</tr>
<tr>
<td>McGeorge Law Review</td>
</tr>
<tr>
<td>McGill Law Journal</td>
</tr>
<tr>
<td>Media</td>
</tr>
<tr>
<td>Mediation</td>
</tr>
<tr>
<td>Medialine</td>
</tr>
<tr>
<td>Melbourne University Law Review</td>
</tr>
<tr>
<td>Mercer Law Review</td>
</tr>
<tr>
<td>Michigan Business Law Journal</td>
</tr>
<tr>
<td>Michigan Journal of Gender &amp; Law</td>
</tr>
<tr>
<td>Michigan Journal of International Law</td>
</tr>
<tr>
<td>Michigan Journal of Race &amp; Law</td>
</tr>
<tr>
<td>Michigan Law Review</td>
</tr>
<tr>
<td>Michigan State Law Review</td>
</tr>
<tr>
<td>Michigan Telecommunications and Technology Law Review</td>
</tr>
<tr>
<td>Military Law Review</td>
</tr>
<tr>
<td>Mineral</td>
</tr>
<tr>
<td>Minnesota Intellectual Property Review</td>
</tr>
<tr>
<td>Minnesota Journal of International Law</td>
</tr>
<tr>
<td>Minnesota Journal of Global Trade</td>
</tr>
<tr>
<td>Minnesota Journal of Law, Science &amp; Technology</td>
</tr>
<tr>
<td>Minnesota Law Review</td>
</tr>
<tr>
<td>Mississippi College Law Review</td>
</tr>
<tr>
<td>Mississippi Law Journal</td>
</tr>
<tr>
<td>Missouri Environmental Law and Policy Review</td>
</tr>
<tr>
<td>Missouri Law Review</td>
</tr>
</tbody>
</table>
Periodicals

- Modern Law Review
- Monash University Law Review
- Montana Law Review
- Monthly
- Monthly Labor Review
- Municipal
- National
- National Black Law Journal
- Natural
- Natural Resources Journal
- Naval Law Review
- Nebraska Law Review
- Negligence
- Nevada Law Journal
- New England International and Comparative Law Annual
- New England Journal of Medicine
- New England Journal on Criminal and Civil Confinement
- New England Law Review
- New Law Journal
- New Mexico Law Review
- New York City Law Review
- New York International Law Review
- New York Law Journal
- New York Law School Journal of Human Rights
- New York Law School Journal of International and Comparative Law
- New York Law School Law Review
- New York State Bar Association Antitrust Law Symposium
- New York Times
- New York University Annual Institute on Federal Taxation
- New York University Annual Survey of American Law
- New York University Environmental Law Journal
- New York University Journal of International Law and Politics
- New York University Journal of Legislation and Public Policy
- New York University Law Review
- New York University Review of Law and Social Change
- New York University School of Law Moot Court Casebook
- Newsletter
- NEXUS: A Journal of Opinion
- MOD. L. REV.
- MONASH U. L. REV.
- MONT. L. REV.
- MONTHLY
- MONTHLY LAB. REV.
- MUN.
- NAT'L
- NAT'L BLACK L.J.
- NAT.
- NAT. RESOURCES J.
- NAVAL L. REV.
- NEB. L. REV.
- NEGL.
- NEV. L.J.
- NEW ENG. INT'L & COMP. L. ANN.
- NEW ENG. J. MED.
- NEW ENG. J. ON CRIM. & CIV. CONFINEMENT
- NEW ENG. L. REV.
- NEW L.J.
- N.M. L. REV.
- N.Y. CITY L. REV.
- N.Y. INT'L L. REV.
- N.Y. L.J.
- N.Y.L. SCH. J. HUM. RTS.
- N.Y.L. SCH. J. INT'L & COMP. L.
- N.Y.L. SCH. L. REV.
- N.Y. ST. B.A. ANTITRUST L. SYMP.
- N.Y. TIMES
- N.Y.U. ANN. INST. ON FED. TAX'N.
- N.Y.U. ANN. SURV. AM. L.
- N.Y.U. ENVTL. L.J.
- N.Y.U. J. INT'L L. & POL.
- N.Y.U. J. LEGIS. & PUB. POL'Y
- N.Y.U. L. REV.
- N.Y.U. REV. L. & SOC. CHANGE
- N.Y.U. MOOT CT. CASEBOOK
- NEWSL.
- NEXUS
North Carolina Banking Institute
North Carolina Central Law Review
North Carolina Journal of International Law and Commercial Regulation
North Carolina Law Review
North Dakota Law Review
Northern Illinois University Law Review
Northern Kentucky Law Review
Northwestern Journal of International Law & Business
Northwestern University Law Review
Notre Dame
Notre Dame Journal of Law, Ethics & Public Policy
Notre Dame Law Review
Nova Law Review

Ocean and Coastal Law Journal
Office
Ohio Northern University Law Review
Ohio State Journal on Dispute Resolution
Ohio State Law Journal
Oil and Gas Tax Quarterly
Oil, Gas & Energy Quarterly
Oklahoma City University Law Review
Oklahoma Law Review
on
Order
Oregon Law Review
Oregon Review of International Law
Organization
Osgoode Hall Law Journal
Ottawa Law Review
Ottawa Law Review
Pace Environmental Law Review
Pace International Law Review
Pace Law Review
Pacific
Pacific Law Journal
Pacific Rim Law & Policy Journal
Parker School Journal of East European Law
Patent
Patent Law Annual
Penn State Environmental Law Review

N.
N.C. BANKING INST.
N.C. CENT. L. REV.
N.C. J. INT’L L. & COM. REG.
N.C. L. REV.
N.D. L. REV.
N. ILL. U. L. REV.
N. KY. L. REV.
NW. J. INT’L L. & BUS.
NW. U. L. REV.
NOTA BENE
NOTRE DAME J.L. ETHICS & PUB. POL’Y
NOTRE DAME L. REV.
NOVA L. REV.

OCEAN & COASTAL L.J.
OFF.
OHIO N.U. L. REV.
OHIO ST. J. ON DISP. RESOL.
OHIO ST. L.J.
OIL & GAS TAX Q.
OIL GAS & ENERGY Q.
OKLA. CITY U. L. REV.
OKLA. L. REV.
on
ORD.
OR. L. REV.
OR. REV. INT’L L.
ORG.
OSGOODE HALL L.J.
OTAGO L. REV.
OTTAWA L. REV.
PACE ENVTL. L. REV.
PACE INT’L L. REV.
PACE L. REV.
PAC.
PAC. L.J.
PAC. RIM L. & POL’Y J.
PARKER SCH. J. E. EUR. L.
PAT.
PAT. L. ANN.
PENN ST. ENVTL. L. REV.
Periodicals

- Penn State International Law Review
- Penn State Law Review
- Pepperdine Law Review
- Personal
- Perspective[s]
- Philosophical
- Planning
- Police
- Policy
- Politic(al, s)
- Practical Lawyer
- Preview of United States Supreme Court Cases
- Probate
- Probate Law Journal (National College of Probate Judges and Boston University School of Law)
- Probation
- Problems
- Proceedings, dure
- Profession(al, al)
- Property
- Psychiatry
- Psychological
- Psychology, Public Policy, and Law
- Public
- Public Contract Law Journal
- Public Interest Law Reporter
- Public Land and Resources Law Review
- Publishing, Entertainment, Advertising and Allied Fields Law Quarterly

Q-R

- Quarterly
- Quinnipiac Health Law Journal
- Quinnipiac Law Review
- Quinnipiac Probate Law Journal
- Race and Ethnic Ancestry Law Journal
- Real
- Real Property, Probate and Trust Journal
- Record
- Referee[s]
- Reform
- Regent University Law Review
- Register
- Regulation
- Relations
› Report[s, cr]
› Reproduct[ion, ive]
› Research
› Reserve
› Resolution
› Resources
› Responsibility
› Review
› Review of Litigation
› Revista de Derecho Puertorriqueño
› Revista Jurídica de la Universidad de Puerto Rico
› Richmond Journal of Global Law & Business
› Richmond Journal of Law and the Public Interest
› Richmond Journal of Law & Technology
› Rights
› Risk
› RISK: Health, Safety & Environment
› Rocky Mountain Mineral Law Institute
› Roger Williams University Law Review
› Rutgers Computer and Technology Law Journal
› Rutgers Law Journal
› Rutgers Law Record
› Rutgers Law Review
› Rutgers Race and the Law Review

S-T
› St. John's Journal of Civil Rights and Economic Development
› St. John's Law Review
› Saint Louis University Law Journal
› Saint Louis University Public Law Review
› Saint Louis-Warsaw Transatlantic Law Journal
› St. Mary's Law Journal
› St. Thomas Law Review
› San Diego Law Review
› San Fernando Valley Law Review
› Santa Clara Computer and High Technology Law Journal
› Santa Clara Journal of International Law
› Santa Clara Law Review
› The Scholar: St. Mary's Law Review on Minority Issues
› School
› Scien[ce, ces, tific]
› Scientific American

REP.
REPROD.
RES.
RES.
RESOL.
RESOURCES
RESP.
REV.
REV. LITIG.
REV. DER. P.R.
REV. JUR. U.P.R.
RICH. J. GLOBAL L. & BUS.
RICH. J.L. & PUB. INT.
RICH. J.L. & TECH.
RTS.
RISK
RISK
ROCKY MTN. MIN. L. INST.
ROGER WILLIAMS U. L. REV.
RUTGERS COMPUTER & TECH. L.J.
RUTGERS L.J.
RUTGERS L. REC.
RUTGERS L. REV.
RUTGERS RACE & L. REV.
Periodicals

- Scottish
- Seattle University Law Review
- Section
- Securities
- Sentencing
- Seton Hall Constitutional Law Journal
- Seton Hall Journal of Sport Law
- Seton Hall Journal of Sports and Entertainment Law
- Seton Hall Law Review
- Seton Hall Legislative Journal
- Signs
- Social
- Social Service Review
- Socialist
- Society
- Sociological
- Software Law Journal
- Solicitor[s, s', s]
- South[ern]
- South Carolina Environmental Law Journal
- South Carolina Law Review
- South Dakota Law Review
- South Texas Law Review
- Southeastern Environmental Law Journal
- Southern California Interdisciplinary Law Journal
- Southern California Law Review
- Southern California Review of Law & Social Justice
- Southern Illinois University Law Journal
- Southern Methodist University Law Journal
- Southern University Law Review
- Southwestern Journal of International Law
- Southwestern Law Journal
- Southwestern University Law Review
- Sports Lawyers Journal
- Stanford Environmental Law Journal
- Stanford Journal of Civil Rights and Civil Liberties
- Stanford Journal of International Law
- Stanford Journal of Law, Business & Finance
- Stanford Law & Policy Review
- Stanford Law Review
- Stanford Technology Law Review
- State
- State Bar of Texas Environmental Law Journal
- Statistic[s, al]
- Stetson Law Review
- SCOT.
- SEATTLE U. L. REV.
- SEC.
- SEC.
- SENT'G
- SETON HALL CONST. L.J.
- SETON HALL J. SPORT L.
- SETON HALL J. SPORTS & ENT. L.
- SETON HALL L. REV.
- SETON HALL LEGIS. J.
- SIGNS
- SOC.
- SOC. SERV. REV.
- SOCIALIST
- SOC'Y
- SOFTWARE L.J.
- SOLIC.
- S.
- S.C. ENVTL. L.J.
- S.C. L. REV.
- S.D. L. REV.
- S. TEX. L. REV.
- SOUTHEASTERN ENVTL. L.J.
- S. CAL. INTERDISC. L.J.
- S. CAL. L. REV.
- S. CAL. REV. L. & SOC. JUST.
- S. ILL. U. L.J.
- SMU L. REV.
- S.U. L. REV.
- SW. J. INT'L LAW
- SW. L.J.
- SW. U. L. REV.
- SPORTS LAW. J.
- STAN. ENVTL. L.J.
- STAN. J. C.R. & C.L.
- STAN. J. INT'L L.
- STAN. J.L. BUS. & FIN.
- STAN. L. & POL'Y REV.
- STAN. L. REV.
- STAN. TECH. L. REV.
- ST.
- ST. B. TEX. ENVTL. L.J.
- STAT.
- STETSON L. REV.
- Thomas M. Cooley Journal of Practical and Clinical Law
- Thomas M. Cooley Law Review
- Thurgood Marshall Law Review
- Toledo Journal of Great Lakes' Law, Science & Policy
- Tort Trial & Insurance Practice Law Journal
- Touro International Law Review
- Touro Journal of Transnational Law
- Touro Law Review
- Trade
- Trademark
- Trademark Reporter
- Transnational
- Transnational Law & Contemporary Problems
- The Transnational Lawyer
- Transportation
- Transportation Law Journal
- Trial
- Trial Lawyer's Guide
- Tribune
- Trust[s]
- Tulane Environmental Law Journal
- Tulane European and Civil Law Forum
- Tulane Journal of International and Comparative Law
- Tulane Journal of Law and Sexuality
- Tulane Law Review
- Tulane Maritime Law Journal
- Tulsa Journal of Comparative & International Law
- Tulsa Law Journal
- Tulsa Law Review

U-V
- UCLA Bulletin of Law and Technology
- UCLA Journal of Law and Technology
- UCLA Entertainment Law Review
- UCLA Journal of Environmental Law & Policy
- UCLA Journal of International Law and Foreign Affairs
- UCLA Law Review
- UCLA Pacific Basin Law Journal
- UCLA Women's Law Journal
- UMKC Law Review
- UN Monthly Chronicle

UCLA BULL. L. & TECH.
UCLA J. L. & TECH.
UCLA ENT. L. REV.
UCLA J. ENVTL. L. & POL’Y
UCLA J. INT’L & FOREIGN AFF.
UCLA L. REV.
UCLA PAC. BASIN L.J.
UCLA WOMEN’S L.J.
UMKC L. REV.
UN MONTHLY CHRON.
<table>
<thead>
<tr>
<th>Periodicals</th>
<th>UCC L.J.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uniform Commercial</td>
<td>Uniform Commercial</td>
</tr>
<tr>
<td>United States</td>
<td></td>
</tr>
<tr>
<td>United States-Mexico</td>
<td></td>
</tr>
<tr>
<td>Law Journal</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Arkansas at Little</td>
<td></td>
</tr>
<tr>
<td>Rock Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Baltimore</td>
<td></td>
</tr>
<tr>
<td>Intellectual Property</td>
<td></td>
</tr>
<tr>
<td>Law Journal</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Baltimore Journal</td>
<td></td>
</tr>
<tr>
<td>of Environmental</td>
<td></td>
</tr>
<tr>
<td>Law</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Baltimore Law Forum</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Baltimore Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>California at Davis</td>
<td></td>
</tr>
<tr>
<td>Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Chicago Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Chicago Legal Forum</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Cincinnati Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Colorado Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Dayton Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Denver Water Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Detroit Mercy Law Review</td>
<td></td>
</tr>
<tr>
<td>University of the</td>
<td></td>
</tr>
<tr>
<td>District of Columbia</td>
<td></td>
</tr>
<tr>
<td>David Clarke School</td>
<td></td>
</tr>
<tr>
<td>of Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Florida Journal of</td>
<td></td>
</tr>
<tr>
<td>Law and Public Policy</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Florida Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Hawaii Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Illinois Journal of</td>
<td></td>
</tr>
<tr>
<td>Law, Technology and</td>
<td></td>
</tr>
<tr>
<td>Policy</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Illinois Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Kansas Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Memphis Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Miami Business Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Miami Inter-American Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Miami International and</td>
<td></td>
</tr>
<tr>
<td>Comparative Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Miami Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Miami Yearbook of</td>
<td></td>
</tr>
<tr>
<td>International Law</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Michigan Journal of</td>
<td></td>
</tr>
<tr>
<td>Law Reform</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Pennsylvania Journal of</td>
<td></td>
</tr>
<tr>
<td>Constitutional Law</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Pennsylvania Journal of</td>
<td></td>
</tr>
<tr>
<td>International Economic Law</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Pennsylvania Journal of</td>
<td></td>
</tr>
<tr>
<td>Labor and Employment Law</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Pennsylvania Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Pittsburgh Law Review</td>
<td></td>
</tr>
<tr>
<td>University of</td>
<td></td>
</tr>
<tr>
<td>Puget Sound Law Review</td>
<td></td>
</tr>
</tbody>
</table>
Periodicals

- University of Richmond Law Review
- University of San Francisco Law Review
- University of San Francisco Maritime Law Journal
- University of Seattle Law Review
- University of Toledo Law Review
- University of Toronto Faculty of Law Review
- University of Toronto Law Journal
- University of West Los Angeles Law Review
- Urban
- Urban Lawyer
- Utah Law Review
- Utilities
- Valparaiso University Law Review
- Vanderbilt Journal of Entertainment & Technology Law
- Vanderbilt Journal of Transnational Law
- Vanderbilt Law Review
- Vermont Journal of Environmental Law
- Vermont Law Review
- Villanova Environmental Law Journal
- Villanova Law Review
- Villanova Sports & Entertainment Law Journal
- Virginia Environmental Law Journal
- Virginia Journal of International Law
- Virginia Journal of Law & Technology
- Virginia Journal of Social Policy & the Law
- Virginia Sports and Entertainment Law Journal
- Virginia Law Review
- Virginia Law & Business Review
- Virginia Tax Review

W-X

- Wake Forest Law Review
- Wall Street Journal
- Washburn Law Journal
- Washington and Lee Journal of Civil Rights and Social Justice
- Washington and Lee Law Review
- Washington Law Review
- Washington Monthly
- Washington Post
- Washington University Global Studies Law Review
- Washington University Journal of Law and Policy

Wake Forest L. Rev.
WALL ST. J.
WASHBURN L.J.
WASH. & LEE J. CIVIL RTS. & SOC. JUST.
WASH. & LEE L. REV.
WASH. & LEE RACE & ETHNIC ANC. L.J.
WASH. L. REV.
WASH. MONTHLY
WASH. POST
WASH. U. GLOB. STUD. L. REV.
WASH. U. J.L. & POL'Y
<table>
<thead>
<tr>
<th>Periodicals</th>
<th>WASH. U. J. URB. &amp; CONTEMP. L.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washington University Journal of Urban and</td>
<td>Washington University Law Review</td>
</tr>
<tr>
<td>Contemporary Law</td>
<td>Wayne L. Rev.</td>
</tr>
<tr>
<td>Wayne Law Review</td>
<td>Wk.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Wkly.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Welfare</td>
</tr>
<tr>
<td>Wayne L. Rev.</td>
<td>W.</td>
</tr>
<tr>
<td>Wisconsin International Law Journal</td>
<td>W. NEW ENG. L. REV.</td>
</tr>
<tr>
<td>Wisconsin Law Review</td>
<td>W. ST. U. L. REV.</td>
</tr>
<tr>
<td>Wisconsin Women's Law Journal</td>
<td>WHITTIER L. REV.</td>
</tr>
<tr>
<td>Women</td>
<td>WIDENER J. PUB. L.</td>
</tr>
<tr>
<td>Women's Rights Law Reporter</td>
<td>WIDENER L. REV.</td>
</tr>
<tr>
<td>World</td>
<td>WIDENER L. SYMP. J.</td>
</tr>
<tr>
<td>Wyoming Law Review</td>
<td>WILLAMETTE L. REV.</td>
</tr>
<tr>
<td>World</td>
<td>WM. &amp; MARY BILL RTS. J.</td>
</tr>
<tr>
<td>Women's Rights Law Reporter</td>
<td>WM. &amp; MARY J. WOMEN &amp; L.</td>
</tr>
<tr>
<td>World</td>
<td>WILLAMETTE L. REV.</td>
</tr>
<tr>
<td>Women</td>
<td>WM. &amp; MARY L. REV.</td>
</tr>
<tr>
<td>Yale Human Rights and Development Law Journal</td>
<td>WM. MITCHELL L. REV.</td>
</tr>
<tr>
<td>Yale Journal of Health Policy, Law, and Ethics</td>
<td>WIS. ENVT'L L.J.</td>
</tr>
<tr>
<td>Yale Journal of International Law</td>
<td>WIS. INT'L L.J.</td>
</tr>
<tr>
<td>Yale Journal of Law and Feminism</td>
<td>WIS. L. REV.</td>
</tr>
<tr>
<td>Yale Journal of Law &amp; the Humanities</td>
<td>WIS. WOMEN'S L.J.</td>
</tr>
<tr>
<td>Yale Journal of Law &amp; Technology</td>
<td>WOMEN</td>
</tr>
<tr>
<td>Yale Journal of World Public Order</td>
<td>WOMEN'S RTS. L. REP.</td>
</tr>
<tr>
<td>Yale Journal on Regulation</td>
<td>WORLD</td>
</tr>
<tr>
<td>Yale Law &amp; Policy Review</td>
<td>WYOM. L. REV.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE HUM. RTS. &amp; DEV. L.J.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J. HEALTH POL'Y L. &amp; ETHICS</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J. INT'L L.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J.L. &amp; FEMINISM</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J.L. &amp; HUMAN.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J.L. &amp; TECH.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J. WORLD PUB. ORD.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE J. ON REG.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE L. &amp; POL'Y REV.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>YALE L.J.</td>
</tr>
<tr>
<td>Yale Law Journal</td>
<td>Y.B.</td>
</tr>
<tr>
<td>Yearbook (or Year Book)</td>
<td>YALE L. REV.</td>
</tr>
</tbody>
</table>